Eleventh Edition, version 9.3.1

To ensure that you are using the documentation that corresponds to the software you are licensed to use, compare this version number with the software version shown in “About MicroStrategy...” in the Help menu of your software.

Document number: 09570931
Copyright © 2012 by MicroStrategy Incorporated. All rights reserved.

If you have not executed a written or electronic agreement with MicroStrategy or any authorized MicroStrategy distributor, the following terms apply:

This software and documentation are the proprietary and confidential information of MicroStrategy Incorporated and may not be provided to any other person. Copyright © 2001-2012 by MicroStrategy Incorporated. All rights reserved.

THIS SOFTWARE AND DOCUMENTATION ARE PROVIDED "AS IS" AND WITHOUT EXPRESS OR LIMITED WARRANTY OF ANY KIND BY EITHER MICROSTRATEGY INCORPORATED OR ANYONE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE OR DOCUMENTATION, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, GOOD TITLE AND NONINFRINGEMENT. QUALITY OR ACCURACY. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE AND DOCUMENTATION IS WITH YOU. SHOULD THE SOFTWARE OR DOCUMENTATION PROVE DEFECTIVE, YOU (AND NOT MICROSTRATEGY, INC. OR ANYONE ELSE WHO HAS BEEN INVOLVED WITH THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE OR DOCUMENTATION) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

In no event will MicroStrategy, Inc. or any other person involved with the creation, production, or distribution of the Software be liable to you on account of any claim for damage, including any lost profits, lost savings, or other special, incidental, consequential, or exemplary damages, including but not limited to any damages assessed against or paid by you to any third party, arising from the use, inability to use, quality, or performance of such Software and Documentation, even if MicroStrategy, Inc. or any such other person or entity has been advised of the possibility of such damages, or for the claim by any other party. In addition, MicroStrategy, Inc. or any other person involved in the creation, production, or distribution of the Software shall not be liable for any claim by you or any other person for damages arising from the use, inability to use, quality, or performance of such Software and Documentation, based upon principles of contract warranty, negligence, strict liability for the negligence of indemnity or contribution, the failure of any remedy to achieve its essential purpose or otherwise. The entire liability of MicroStrategy, Inc. and your exclusive remedy shall not exceed, at the option of MicroStrategy, Inc. either a full refund of the price paid, or replacement of the Software. No oral or written information given out expands the liability of MicroStrategy, Inc. beyond that specified in the above limitation of liability. Some states do not allow the limitation or exclusion of liability for incidental or consequential damages, so the above limitation may not apply to you.

The information contained in this manual (the Documentation) and the Software are copyrighted and all rights are reserved by MicroStrategy, Inc. MicroStrategy, Inc. reserves the right to make periodic modifications to the Software or the Documentation without obligation to notify any person or entity of such revision. Copying, duplicating, selling, or otherwise distributing any part of the Software or Documentation without prior written consent of an authorized representative of MicroStrategy, Inc. are prohibited. U.S. Government Restricted Rights. Rights in this documentation were developed at private expense, that no part is public domain, and that the Software and Documentation are Commercial Computer Software provided with RESTRICTED RIGHTS under Federal Acquisition Regulations and agency supplements to them. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFAR 252.227-7013 et seq. or subparagraphs (c)(1) and (2) of the Commercial Computer Software—Restricted Rights at FAR 52.227-19, as applicable.

Contractor is MicroStrategy, Inc., 1850 Towers Crescent Plaza, Tysons Corner, VA 22182. Rights are reserved under copyright laws of the United States with respect to unpublished portions of the Software.

The following are either trademarks or registered trademarks of MicroStrategy Incorporated in the United States and certain other countries:

All other company and product names may be trademarks of the respective companies with which they are associated. Specifications subject to change without notice. MicroStrategy is not responsible for errors or omissions. MicroStrategy makes no warranties or commitments concerning the availability of future products or versions that may be planned or under development.

Patent Information

This product is patented. One or more of the following patents may apply to the product sold herein: U.S. Patent Nos. 6,154,766, 6,173,310, 6,260,050, 6,263,051, 6,269,393, 6,279,033, 6,567,796, 6,587,547, 6,606,596, 6,658,093, 6,658,432, 6,602,195, 6,671,715, 6,691,100, 6,694,316, 6,697,808, 6,704,723, 6,741,980, 6,765,997, 6,768,788, 6,772,137, 6,788,768, 6,798,867, 6,801,900, 6,820,073, 6,823,334, 6,836,537, 6,850,603, 6,859,798, 6,863,973, 6,885,734, 6,904,953, 6,964,012, 6,977,992, 6,996,568, 6,996,569, 7,003,515, 7,010,518, 7,016,480, 7,020,251, 7,039,165, 7,062,422, 7,113,993, 7,127,403, 7,174,349, 7,181,417, 7,194,457, 7,197,481, 7,228,303, 7,260,577, 7,266,181, 7,272,212, 7,302,639, 7,324,942, 7,330,947, 7,340,040, 7,356,758, 7,356,840, 7,415,438, 7,428,302, 7,430,562, 7,440,898, 7,486,780, 7,509,671, 7,516,181, 7,559,048, 7,574,376, 7,617,201, 7,725,811, 7,801,967, 7,836,178, 7,861,161, 7,861,253, 7,881,443, 7,925,616, 7,945,584, 7,970,762, 8,005,870, 8,051,168, 8,051,369, 8,094,788, and 8,190,816. Other patent applications are pending.

Various MicroStrategy products contain the copyrighted technology of third parties. This product may contain one or more of the following copyrighted technologies:

Graph Generation Engine Copyright © 1998-2012. Three D Graphics, Inc. All rights reserved. Actuate® Formula One. Copyright © 1993-2012 Actuate Corporation. All rights reserved.
XML parser Copyright © 2003-2012 Microsoft Corporation. All rights reserved.
Xalan XSLT processor. Copyright © 1999-2012. The Apache Software Foundation. All rights reserved.
Xerces XML parser. Copyright © 1999-2012. The Apache Software Foundation. All rights reserved.
FOP XSLT formatting objects. Copyright © 2004-2012. The Apache Software Foundation. All rights reserved.
Portions of Intellgent Server memory management Copyright © 1991-2012 Compuware Corporation. All rights reserved.
ASIHTTPRequest library. Copyright © 2007-2012, All-Seeing Interactive. All rights reserved.

This product includes software developed by the OpenSLL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)
CONTENTS

1. Get Started with the MicroStrategy Suite

Introduction ........................................................................................................... 1
Upgrading your existing installation ................................................................. 2
Installation prerequisites .................................................................................. 2
  Understanding the MicroStrategy components ............................................ 2
  Understanding licensing ............................................................................... 4
  Hardware requirements and recommendations .......................................... 5
  Software requirements and recommendations ............................................ 6
Supporting UNIX and Linux environments ...................................................... 8
Downloading and extracting the MicroStrategy Suite .................................... 8
Installing the MicroStrategy Suite ................................................................. 10
  Installing the iPhone or iPad client ............................................................ 17
  Installing the Android client ...................................................................... 18
  Installing the Mobile BlackBerry client ...................................................... 18
Configuring the MicroStrategy Suite ............................................................ 19
  Configuring MicroStrategy Web ................................................................. 30
  Connecting MicroStrategy Mobile Server ................................................. 37
  Configuring the Mobile client ................................................................... 39

2. Creating a MicroStrategy Project with Your Data

Introduction ....................................................................................................... 55
About projects, attributes, facts, metrics, and hierarchies ............................... 55
Creating a project, attributes, facts, and hierarchies ........................................ 57
  Creating a DSN to connect to your data source ......................................... 58
  Creating a database instance to access your data source .......................... 60
  Creating a project to contain reports and report objects ........................... 63
  Creating attributes, facts, and hierarchies ................................................. 67
Creating metrics .............................................................................................. 79
B. Additional Resources

Online support, training, and videos .......................................... 177
Documentation........................................................................... 178
MicroStrategy overview and evaluation ................................. 178
Resources for MicroStrategy Social Intelligence ................. 179
Manuals for query, reporting, and analysis .................... 179
Manuals for Analytics Modules ............................................ 182
Manuals for Narrowcast Services products ....................... 182
Software Development Kits ................................................ 182
Documentation for MicroStrategy Portlets ....................... 183
Documentation for MicroStrategy GIS Connectors .......... 183
Help ..................................................................................... 184
Accessing manuals and other documentation sources .... 184
Accessing additional documentation resources prior to installation.................................................... 186
Documentation standards.................................................... 187
Additional formats ................................................................ 188
GET STARTED WITH THE MICROSTRATEGY SUITE

Introduction

The MicroStrategy Suite is a free software bundle that gives you premium reporting and mobile app development capabilities to quickly develop and deliver mobile apps, dashboards, and reports from your data.

The steps below show you how to download, install, activate, and configure the MicroStrategy Suite.

MicroStrategy Mobile client apps are available as free downloads from Apple’s App Store (for iPhones and iPads) and from Google Play (for Android phones and tablets). The free client apps contain sample MicroStrategy dashboards and sample apps. Before setting up your own production-ready apps that run against your own data, you can tour the sample MicroStrategy applications available. For steps to download the free client with sample apps for MicroStrategy Mobile for the iPhone and MicroStrategy Mobile for the iPad, see Installing the iPhone or iPad client, page 17. For steps to download the free client with sample apps for MicroStrategy Mobile for Android, see Installing the Android client, page 18. After you explore the sample apps, proceed with the steps in this guide to set up MicroStrategy Mobile to display dashboards with your own data on an iPhone, iPad, or Android device.
Upgrading your existing installation

If you have already installed and configured your MicroStrategy Suite and you are upgrading your software, complete only the following steps:


1. Download and extract the new version of the MicroStrategy Suite. The steps to complete this task are provided in this guide.

2. See the MicroStrategy Upgrade Guide for important pre-installation information and all the steps you need to complete the upgrade process.

Installation prerequisites

Before you install the MicroStrategy Suite, review the following prerequisites:

- Understanding the MicroStrategy components, page 2
- Understanding licensing, page 4
- Hardware requirements and recommendations, page 5
- Software requirements and recommendations, page 6
- Supporting UNIX and Linux environments, page 8
- Downloading and extracting the MicroStrategy Suite, page 8

Understanding the MicroStrategy components

The MicroStrategy Suite includes the MicroStrategy products and components required to provide mobile business intelligence applications and premium reporting capabilities to quickly develop and deliver operational and analytical reports from your data.
General requirements and information on the installation of the products and components provided with the MicroStrategy Suite are provided below:


- MicroStrategy Report Services, OLAP Services, and Distribution Services are installed with MicroStrategy Intelligence Server.


- MicroStrategy Mobile has the following components:
  - MicroStrategy Mobile Server, which supports the MicroStrategy Mobile client applications for iPhones, iPads, Android phones and tablets, and BlackBerry devices.
  - An iPhone client application, which is installed on iPhones and an iPad client application, which is installed on iPads. For steps to install the client application on iPhones or iPads, see Installing the iPhone or iPad client, page 17.
  - An Android client application, which is installed on Android phones and tablets. For steps to install the client application on Androids, see Installing the Android client, page 18.
  - A BlackBerry client application, which is installed on BlackBerry smartphones. For steps to install the client application on BlackBerry smartphones, see Installing the Mobile BlackBerry client, page 18.

- MicroStrategy Office has two components: MicroStrategy Web Services which is installed with MicroStrategy Web Reporter, and the MicroStrategy Office client application which is installed on end user computers running Microsoft Office.

  For information on allowing users to install the MicroStrategy Office client application from a network location, refer to Chapter 1, Planning Your Installation in the Installation and Configuration Guide. For other methods of installing the MicroStrategy Office client, refer to Chapter 1, Getting Started with MicroStrategy Office in the MicroStrategy Office User Guide.

- You can install the following sample MicroStrategy projects, which are stored in Microsoft Access databases and can be installed on Windows operating systems:
MicroStrategy Tutorial is a sample MicroStrategy project with a metadata and warehouse, and a set of demonstration dashboards and reports designed to illustrate the platform's rich functionality. For more information on the Tutorial project and disabling sample users in that project, see Addressing issues with number of users, page 176.

MicroStrategy Analytics Modules are a set of packaged analytic components built using the MicroStrategy platform. The modules can be mapped to a different warehouse or used as starter kits to develop custom reports, dashboards, and applications.

- If you plan to install on a UNIX-based platform, you will be installing MicroStrategy Web Reporter and MicroStrategy Intelligence Server on a UNIX-based platform. Because MicroStrategy Desktop and MicroStrategy Architect are only available on Windows platforms, you must install those applications on computers running Windows to use them.

- For hardware and software requirements specific to MicroStrategy products and components, refer to the MicroStrategy Readme for the products you plan to install.

- For a more detailed description of the products listed above, or for installation configurations other than the example provided in this quick start guide, refer to Chapter 1, Planning Your Installation of the Installation and Configuration Guide.

**Understanding licensing**

Licenses for the MicroStrategy Suite are obtained during the download and installation process, as described in Downloading and extracting the MicroStrategy Suite, page 8. Prior to requesting a license for the MicroStrategy Suite, review the following information:


- The server components have a 1-CPU limit for Intelligence Server. For details on CPU usage, see Addressing issues with number of CPUs, page 175.

- The Suite also includes two complimentary named user licenses for MicroStrategy Web Professional, MicroStrategy Desktop Designer, and...
MicroStrategy Architect, which let you configure and build your business intelligence project.

**Hardware requirements and recommendations**

MicroStrategy acknowledges that variables such as processor speed, CPU type, file space, and physical and swap memory are factors that play an important role in making your deployment of MicroStrategy a successful one. The general hardware requirements for the MicroStrategy Suite are as follows:

- To save the downloaded files and extract the files, your computer needs approximately 5.9 gigabytes (GB) of free hard drive space.

- Your computer needs 4 GB or higher of memory (RAM) to support the MicroStrategy Suite.

- To install the extracted files and support the use of the Suite, your computer needs hard drive space that is three times the amount of RAM available. For example, if you are providing 6 GB of RAM, then the computer needs 18 GB of hard drive space.

- Your computer needs a 1.8 gigahertz (GHz) or higher processor to support the MicroStrategy Suite. For processor chipset support, refer to the MicroStrategy Readme for operating system certification and support information.

- Your iPhone needs 6.6 MB of free space to support the MicroStrategy iPhone client application. In addition, you must have an Apple iPhone running the following:
  - iPhone iOS 4.2.x, 4.3.x, 5.0.x, or 5.1.x
  - iPhone 4S, iPhone 4, iPhone 3G, iPhone 3GS, or iPod Touch devices

- To support the MicroStrategy iPad client application, you must have an Apple iPad with the following requirements:
  - iPad iOS 4.2.x, 4.3.x, 5.0.x, or 5.1.x
  - iPad Wi-Fi or iPad Wi-Fi + 3G devices
  - iPad 2 Wi-Fi or iPad 2 Wi-Fi + 3G devices
  - New iPad Wi-Fi + Cellular devices

- Your Android needs to fit the following requirements:
Get Started with the MicroStrategy Suite

MicroStrategy Suite

Installation prerequisites © 2012 MicroStrategy, Inc.

- Android OS 2.2.x, 2.3.x, 3.x, 4.0.x, or 4.1.x
- Motorola Droid X, Motorola Atrix, Motorola Atrix 2, Motorola Photon, Samsung Nexus S, Samsung Fascinate, LG Revolution, Dell Venue, Samsung Galaxy Tab 10.1 Wi-Fi Only, Motorola Xoom, LG G-Slate, Toshiba Thrive, Acer Iconia Tab A500, ASUS Transformer, Kyocera Echo, Carrefour Touch Tablet 10” CT1002, Motorola Droid Bionic, Lenovo IdeaPadK1, Samsung Galaxy S2 AT&T version, Samsung Galaxy S2 Skyrocket AT&T version, Sony Xperia Arc, Sony Tablet S, TABWay by iTautec 2.2, or Kindle Fire
- Android phones must use a High Pixel Density Screen (HDPI), which is 240ppi to 320ppi
- Android tablets must use a Medium Pixel Density Screen (MDPI), which is 160ppi to 240ppi
- Your BlackBerry smartphone needs 1.72 MB of free space to support the MicroStrategy BlackBerry client application, with the following requirements:
  - You must have a BlackBerry running the following: BlackBerry OS 5.x, 6.x, or 7.x
  - Your BlackBerry device must be one of the following: BlackBerry Bold 9900 Series, Torch 9800 Series, Bold 9790, Bold 9700, Style 9670, Bold 9650, Tour 9630, Curve 3G 9300 Series, Pearl 3G 9100 Series, Bold 9000 Series, Curve 8900 Series, 8800 Series, 8700 Series, Curve 8500 Series, Curve 8300 Series, Pearl Flip 8200 Series, Pearl 8100 Series, 7200 Series, or 7100 Series devices

For guidance on processor speed, RAM, and hard disk requirements for specific MicroStrategy products installed on Windows, UNIX, and Linux platforms, refer to the MicroStrategy Readme for the products you plan to install.

Software requirements and recommendations

- If you are using Internet Explorer to download the zip file, use IE version 7.0 or later, or use another browser. IE 6 has a limitation on the size of files it can download.
- You have an available data source that contains the information for your business. This can be a Microsoft Access database, Microsoft Excel spreadsheet, or some other database or data source.
• You have an available data source that can store the MicroStrategy metadata. This can be an empty Microsoft Access database or another database such as PostgreSQL.

• You must install Microsoft .NET Framework 4.0 prior to installing MicroStrategy.

• To install MicroStrategy Web, MicroStrategy Web Services, and MicroStrategy Mobile Server, you must have a web server such as Microsoft Internet Information Services (IIS) installed. IIS is installed by default on Windows server operating systems, and is an optional component on other Windows operating systems.
  - For information on installing IIS on your Windows operating system, refer to the third-party Microsoft documentation provided at http://www.iis.net/.
  - For information on supporting MicroStrategy products with IIS 7.0 and 6.0, see Installing Microsoft IIS, page 172.
  - For information on supporting other types of web servers, see the MicroStrategy Installation and Configuration Guide.

If you are installing MicroStrategy Web and MicroStrategy Mobile Server on a Microsoft Windows XP computer, you cannot deploy both of these products using IIS. You must do one of the following:

• Install and deploy MicroStrategy Web and MicroStrategy Mobile Server on separate computers.

• Use a web server other than IIS to deploy at least one of these two MicroStrategy products.

• Installing the MicroStrategy Suite to replace an existing MicroStrategy configuration will also replace the licensing terms of the existing MicroStrategy software. This includes previous installations of MicroStrategy products including the MicroStrategy Suite, MicroStrategy Evaluation Edition, and any purchased licenses of any of the MicroStrategy product line. For details on upgrading an installation, see Upgrading your existing installation, page 2. For more information on the licenses provided with the MicroStrategy Suite, see Understanding licensing, page 4.

In addition, MicroStrategy acknowledges that variables such as operating systems, application servers, web servers, JDKs, database management systems, and other supporting software requirements are factors that play an important role in making your deployment of MicroStrategy a successful one. For guidance on these software requirements, refer to the MicroStrategy Readme for the products you plan to install.
Supporting UNIX and Linux environments

If you plan to install on a UNIX-based platform, you will be installing MicroStrategy Web Reporter and MicroStrategy Intelligence Server on a UNIX-based platform. Because MicroStrategy Desktop and MicroStrategy Architect are only available on Windows platforms, you must install those applications on computers running Windows to use them.

For installation configurations other than the example provided in this quick start guide, refer to the Planning Your Installation chapter of the Installation and Configuration Guide.

In addition to this requirement, there are other configurations that allow you to support the MicroStrategy Suite on UNIX-based platforms. The benefits of these configurations are described briefly below:

- **Recommended system settings for UNIX and Linux**: For UNIX and Linux systems, a number of system settings can affect the performance of MicroStrategy Intelligence Server Universal. These settings do not need to be set prior to a MicroStrategy installation. For more information on these settings and their recommended values, refer to Chapter 1, Planning Your Installation in the Installation and Configuration Guide.

- **Configuring shared memory resources**: To improve the performance of MicroStrategy Intelligence Server Universal for large scale production applications, Intelligence Server Universal can be configured to use shared memory resources. To support this configuration, you must ensure that your Intelligence Server Universal host computer uses values greater than or equal to the resource limits. For information on defining these resource limits, refer to Chapter 1, Planning Your Installation in the Installation and Configuration Guide.

Downloading and extracting the MicroStrategy Suite

Before you begin these steps, ensure that you have reviewed the hardware and software requirements listed in Hardware requirements and recommendations, page 5 and Software requirements and recommendations, page 6.
To download the Suite

1. Go to www.microstrategy.com/freereportingsoftware/ and click Download Your Free Software.

2. Log in to the MicroStrategy Resource Center site using your existing MicroStrategy account information, or create an account using your corporate email address. The Request License Key page opens.

3. You can provide answers to the optional questions that are displayed. Then read the notice and licensing information, and if you agree to the terms, select the Yes check box beneath the license.

4. Click Submit. The Download Software page opens, and an email is automatically sent to the email address associated with your MicroStrategy account. This email contains the license key to your MicroStrategy Suite software.

5. On the Download Software page, depending on your computer’s platform and your geographic location (Asia Pacific has a separate set of links), click one of the links to display installation instructions and the link to download your software:
   - Click for Instructions and Download Files for MicroStrategy for Windows
   - Click for Instructions and Download Files for MicroStrategy for Windows (Split version - for slow connections)
   - Click for Instructions and Download Files for MicroStrategy for UNIX, Linux, Solaris, AIX, and HP-UX.

6. Follow the steps and then click the Download Now link to save a compressed file that contains the Suite installation files. To make this file easier to locate, save it to an empty folder.

   If you are downloading the MicroStrategy software for Windows using the split version, download all the zip files provided and place them in a single folder on your computer. Once all files are downloaded, use the WinZip utility to rejoin the files. To rejoin, right-click the .zip file and select to open with WinZip. In the WinZip dialog box that opens, from the Toolbar menu, select Actions, choose Select All, and then click Extract. The full installation will be located in the destination folder once the extraction process is complete.
7 Extract the files.

Once the files are extracted you can install the MicroStrategy Suite using the steps in the next section.

If you are upgrading your MicroStrategy Suite software, see the *MicroStrategy Upgrade Guide* to complete the upgrade process.

You can also review additional documentation resources prior to installing the Suite. For steps, see *Accessing additional documentation resources prior to installation, page 186*.

## Installing the MicroStrategy Suite

Before you begin the installation of the MicroStrategy Suite, review the *Installation prerequisites, page 2*.

The prerequisites listed below are requirements for completing the installation process.

**Prerequisites**

- You have downloaded and extracted the Suite installation files (see *Downloading and extracting the MicroStrategy Suite, page 8*).
- You have the license key that was emailed to you available during the installation steps.
- You have closed all other software applications currently running on your computer.
- To install MicroStrategy, you must have the following permissions and privileges:
  - Windows:
    - You must log on to your computer using a domain account with Windows administrative privileges for the domain or target computer.
    - The user installing MicroStrategy must have write permissions in the installation directory to complete the installation.
UNIX and Linux:

- If you want a non-root user to be the administrator of the server, you must manually change the ownership after running the installation. Intelligence Server operation is dependent on root user privileges and permissions. Therefore, changing the ownership of Intelligence Server to a non-root user is not a certified or recommended practice.

- Only a user with root permissions can register MicroStrategy Intelligence Server as a service. If the Intelligence Server is registered as an application during installation, the root user can register the server as a service after running the installation. For more information on running Intelligence Server as a service, see the MicroStrategy System Administration Guide.

If you do not have the appropriate permissions and privileges, you may see an error code; for details see Resolving error code 0x80070005, page 175.

To install the MicroStrategy Suite

If you are upgrading your existing MicroStrategy Suite software, see the MicroStrategy Upgrade Guide to complete the upgrade process. Do not continue with the installation information in this guide.

1 Navigate to the folder in which you extracted the Suite installation files. If you need to search for this file, it is named as follows:

- MicroStrategyWindows931.zip for Windows
- MicroStrategyLinux931.zip for Linux
- MicroStrategySolaris931.zip for Oracle Solaris
- MicroStrategyAIX931.zip for IBM AIX
- MicroStrategyUX931.zip for HP-UX

2 To begin the installation process, use one of the following options based on the computer’s operating system and whether the computer has Adobe Flash installed:

• For a Windows computer without Adobe Flash support: Open the Installations folder, and double-click setup.exe.

• For a UNIX or Linux computer: Browse to the Installations folder. Depending on your UNIX or Linux environment, browse to one of the following folders:
  - **Solaris**: QueryReportingAnalysis_SunOS
  - **AIX**: QueryReportingAnalysis_AIX
  - **HP-UX**: QueryReportingAnalysis_HP-UX
  - **Linux**: QueryReportingAnalysis_Linux

Then type the following:

```
./setup.sh
```

3 If this is the first time you have installed the MicroStrategy Suite, you are prompted to choose the language for the wizard. Select the appropriate language from the drop-down list and click OK. The MicroStrategy Installation Wizard opens.

4 Click Next.

Guidance on how to proceed with the installation on a Windows platform is provided in the remaining steps below. If you encounter a question or warning message during installation that is not documented in the steps below, contact your system administrator to determine how to proceed with the request, or use any of the resources below:

• For installation on Windows: With the MicroStrategy Installation Wizard open, click Help or press F1 to open the MicroStrategy Installation Wizard Help.

• For installation on UNIX or Linux: Refer to Chapter 3, Installing MicroStrategy on UNIX and Linux of the Installation and Configuration Guide.

• For all platforms, once installation is complete you can access additional documentation and resources to support your use of the MicroStrategy Suite. See Additional Resources, page 177.

5 Read the information on the Welcome screen and click Next. The License Agreement page opens.

6 Read the license agreement, and accept the agreement by selecting the appropriate option. Click Next.
• If you are prompted to stop Windows services, click Yes to allow the Installation Wizard to stop the Windows services and continue with the Suite installation.

The Customer Information page opens.

7 Type your user and company information. You must also type your MicroStrategy Suite license key, which was emailed to you. Click Next. The Setup Type page opens.

8 Accept all defaults and click Next on each installation page until you reach the Select Features page, as shown below.

9 Accept all defaults to install all products and features provided with the Suite, and click Next.

• If you are prompted to stop your web server, click Yes to allow the Installation Wizard to stop your web server and continue with the Suite installation.

• If you are prompted to enable Web Service Extensions, click Yes to allow the Installation Wizard to enable Web Service Extensions and continue with the Suite installation.

The Server Activation page opens.
To request an Activation Code

10 The Server Activation pages request information about your installation. You must provide this information to request a software Activation Code for your MicroStrategy installation. You have 30 days to activate your installation. Click Next. The Server Information page opens.

11 Specify information about your Intelligence Server installation. Enter the following characteristics:

- **Name**: Distinguishes the name of this Intelligence Server installation from any other Intelligence Server installations in your company
- **Location**: Physical location of the computer on which Intelligence Server is installed
- **Use**: Description of how Intelligence Server is used

Click Next. The Installer Information page opens.

12 Specify contact information of the person installing the software. After your installation is complete an email containing the Activation Code is sent to the email address you confirm in this software activation step. Enter the following installer information:

- Specify whether you are an employee of the licensed company or installing on behalf of the licensed company. This installation process assumes that you select *I am an employee of the licensed company*.
- For descriptions of what information to include in the other text fields, press F1 to view the MicroStrategy online help.

Click Next. The Request Activation Code page opens.

13 Select **Yes, I want to request an Activation Code**. An Activation Code is sent to the email address that you provided. This Activation Code is sent after the installation of MicroStrategy products is complete.

*) This Activation Code for the software is different than the Verification Code you may have received for creating your MicroStrategy account.

Click Next.
To define MicroStrategy’s virtual directories

14 Accept all defaults for specifying virtual directory information and click Next. For your reference, the default virtual directory names are listed below:


To complete the installation

15 Windows requires account information to be entered so that you can log into the system. To designate login information, select one of the following:

- To use the default system account for your computer, select Do not set the service account. This option is recommended.
- To specify a login and password, type a login and password, and confirm the password.

Click Next.

16 If you are prompted for URL information for MicroStrategy Web Services, accept the default and click Next.

A message may be displayed stating that the setup could not validate the Web Services URL. Click Yes to proceed with the installation. This occurs because the setup program must stop the web server during installation.

17 Accept all defaults to add the MicroStrategy Office toolbar to the Microsoft Office applications available on your computer. Click Next. The Start Copying Files page opens.

18 This page provides information about the Suite installation you are completing. Click Install to continue with the installation process, which can take several minutes depending on your computer’s hardware configuration.

A message may be displayed stating that the setup could not validate the Web Services URL. Click Yes to proceed with the installation. This occurs because the setup program must stop the web server during installation.
phase, see Resolving an installation issue during the WSE 3.0 phase, page 174.

19 After installation is complete you are prompted to view the MicroStrategy Readme. Click Yes to open the MicroStrategy Readme and review it as necessary. The InstallShield Wizard Complete page also opens.

For steps to access the MicroStrategy Readme and other documentation at a later time, see Additional Resources, page 177.

20 Select Yes, I want to restart my computer now and click Finish. This restart may take more time than a normal restart of your system as components required to support MicroStrategy are installed or updated during this restart.

To activate your MicroStrategy installation

21 After your computer successfully restarts, close the Configuration Wizard that opens by default.

22 Open MicroStrategy License Manager using one of the following options:

- **Windows:** From the Windows Start menu, point to Programs (or All Programs), then MicroStrategy, and then select License Manager. License Manager opens.

- **UNIX/Linux:** In a UNIX or Linux console window, browse to the directory you specified as the home directory during installation. Browse to the folder bin and type ./mstrlicmgr, then press ENTER. The MicroStrategy License Manager opens.

23 Select the License Administration tab. Under Server Activation, select the Activate Server Installation option. Click Next.

24 Select the Server Activation using Activation Code option and enter your software Activation Code (which you received in an email) in the text field. (For details on the Activation Code, see To request an Activation Code, page 14.) Click Next to activate your software installation.

25 Click OK to close the verification message, then click Exit. MicroStrategy License Manager closes.

26 You must restart your Intelligence Server for the activation status to update. You can restart Intelligence Server using the MicroStrategy Service Manager. Click the Service Manager icon at the bottom right corner on the Windows task bar to access the Service Manager. (You can
also access the Service Manager from the Start menu. Point to Programs (or All Programs), then MicroStrategy, then Tools, and then select Service Manager.) The Service Manager opens. Then click Restart.

27 You must also restart your web server for the activation status to update in MicroStrategy Web. Refer to your third-party web server documentation for steps to restart your web server.

Once you have installed the MicroStrategy Suite on your Intelligence Server, if you plan to use MicroStrategy Mobile functionality you must install and configure the MicroStrategy Mobile client on your licensed users’ iPhones, iPads, Androids, or BlackBerrys. See the appropriate steps below.

**Installing the iPhone or iPad client**

For a list of supported iPhone and iPad devices and operating systems, see the MicroStrategy Readme.

To install MicroStrategy Mobile on an iPhone or iPad:

- For the iPhone: Download the MicroStrategy Mobile application from Apple’s App Store onto the iPhone. An image of the app icon as it appears on the App Store is shown below:

![](image1)

- For the iPad: Download the MicroStrategy Mobile for the iPad application from Apple’s App Store onto the iPad. An image of the app as it appears on the App Store is shown below:

![](image2)

Note the following:

- MicroStrategy Mobile for iPhone has been designed and optimized for iPhone usage. It is not optimized for iPad usage. When downloading the app from the App Store, be sure to select the appropriate version, either for your iPhone or iPad, as applicable.

- Downloading applications from the App Store requires an iTunes App Store account. If you are setting up a new iTunes account, you
may need to provide Apple with credit card information. Remember that the MicroStrategy Mobile Apps are both free; you will not incur any charges from MicroStrategy for downloading either of the applications. For details to create an iTunes account, see www.apple.com/support.

- If you want to distribute either application through your company’s internal network, you may be able to enroll in Apple’s iPhone Developer Enterprise Program. For more information about this program, see http://developer.apple.com/programs/iphone/enterprise.

Once the iPhone or iPad client application is installed, you need to configure your MicroStrategy Mobile app on the device. Steps to configure the iPhone or iPad are included in Configuring the MicroStrategy Suite, page 19.

### Installing the Android client

For a list of supported Android devices and operating systems, see the MicroStrategy Readme.

To install MicroStrategy Mobile on an Android, download the MicroStrategy Mobile application from Google Play onto the phone or tablet.

Downloading applications from Google Play requires a Google account. If you are setting up a new account, you may need to provide credit card information. Remember that MicroStrategy Mobile Apps are free; you will not incur any charges from MicroStrategy for downloading any MicroStrategy applications.

Once the Android client application is installed, you need to configure your MicroStrategy Mobile app on the device. Steps to configure the Android device are included in Configuring the MicroStrategy Suite, page 19.

### Installing the Mobile BlackBerry client

MicroStrategy comes with two versions of the BlackBerry client, and it automatically detects which version should be installed on a given BlackBerry (based on the BlackBerry’s OS version.) For a list of supported BlackBerry devices and operating systems, see the MicroStrategy Readme.

If you have previously installed a demonstration version of MicroStrategy Mobile on a BlackBerry, you must uninstall the
You can install the BlackBerry client application on a device in several ways:

- Individual users can tether their BlackBerry to a computer and use the BlackBerry Desktop Manager to install the MicroStrategy Mobile client. In this process, the library file `MSTRMobile.alx` is loaded onto the BlackBerry. This file then automatically loads the appropriate Java files to run the client.

  BlackBerry Desktop Manager must use the same or later version of the BlackBerry software as the device. For example, if Desktop Manager is version 4.1 and the BlackBerry is version 4.2, you will not be able to load the MicroStrategy Mobile client into the device.

  For steps to install using the BlackBerry Desktop Manager, see the documentation provided with your BlackBerry Desktop Manager software.

- You can deploy the application to multiple devices at one time, through the BlackBerry Enterprise Server (BES). For information on this installation method, see the Administering MicroStrategy Mobile chapter in the MicroStrategy Mobile Design and Administration Guide.

- For information on additional installation methods, see the Administering MicroStrategy Mobile chapter in the MicroStrategy Mobile Design and Administration Guide.

By default, the client application is stored on your server in the following location: `C:\Program Files\MicroStrategy\Mobile`. Additional files necessary for deploying the client over the web are stored by default in `C:\Program Files\MicroStrategy\Mobile\BlackBerry Client for Browser Deployment`.

Once the BlackBerry client application is installed, you need to configure your MicroStrategy Mobile app on the device. Steps to configure the BlackBerry device are included in Configuring the MicroStrategy Suite, page 19.

Configuring the MicroStrategy Suite

The MicroStrategy platform contains wizards to guide you through configuring your Suite installation. Use the following list as a high-level
checklist of tasks you will perform to configure your installation (steps for each task are provided after the checklist):

- Create a data source name (DSN) to connect to your database or other data source that is to store the MicroStrategy metadata repository. This is a MicroStrategy storage space for the underlying reporting components and objects you will use to create reports. One metadata repository can store information for many projects. (A project is a container for all of your related reports and dashboards, as well as the objects that you use to create additional reports/dashboards.)

- Create the metadata repository in the data source that you have created a DSN for.

- Establish an Intelligence Server connection to the metadata repository. This connection tells the MicroStrategy Intelligence Server where you have chosen to create the metadata repository. Intelligence Server can connect to only one metadata repository at a time.

- Set up project sources to connect to your new metadata repository through Intelligence Server. Other MicroStrategy products connect to Intelligence Server using project sources, creating a single, communicating whole so that your reports reflect your stored data.

The following steps assume that you are configuring the Suite on a Windows platform. For detailed steps to configure MicroStrategy on a Linux, AIX, Solaris, or HP-UX platform, see the Installing MicroStrategy on UNIX and Linux chapter of the Installation and Configuration Guide.

Prerequisites

- You have an available data source that can store the MicroStrategy metadata. This can be an empty Microsoft Access database or another database such as PostgreSQL. Be aware that the MicroStrategy metadata repository cannot be stored in a Microsoft Excel spreadsheet.

---

To configure the MicroStrategy Suite

To create a DSN for your metadata repository

This DSN connects to the data source where you plan to create the metadata repository.

1 From the Start menu, point to Programs (or All Programs), then MicroStrategy, then Tools, and then select Connectivity Wizard. The Welcome page opens.
Click **Next**. A list of database drivers is displayed, as shown below. Users of the MicroStrategy platform can select the appropriate certified, MicroStrategy-branded ODBC driver to connect MicroStrategy products to various databases and other data sources.

Select a database driver with which to create a DSN:

- For a Microsoft Access database, select **Other Relational Databases** and click **Next**. Select the appropriate database driver and click **Next**. Options to define the connection to your Microsoft Access data source are displayed. Complete the required information and click **OK** to create the DSN. Proceed to *To create a metadata repository, page 22*, which provides the steps to create a MicroStrategy metadata.

- For a database such as PostgreSQL or Microsoft SQL Server, select the appropriate database driver for your data source and click **Next**. The Driver Details page opens.

- For a database that is not listed in the database driver options, select **Other Relational Databases** and click **Next**. This allows you to select from all database drivers installed on your system.

Complete the information in the appropriate fields for connecting with the selected database driver to your data source. The information to enter varies depending on the database platform on which you are installing the MicroStrategy software.
5 Depending on the database driver you selected, you may be able to test the connection. If the Test option is available, follow these substeps:

a Click Test to open the Test Connection dialog box.

b If your database requires a login and password, type the User Name and Password to connect to the database.

c Click Connect to test and verify the connection. If the test is performed successfully, the connection with the database is established. If the test fails, verify the correct connection information with your database administrator and make any required changes to the information you provided in the previous steps.

d Click Close. The Test Connection dialog box closes.

6 Click Finish to create the new DSN.

To create a metadata repository

7 From the Start menu, point to Programs (or All Programs), then MicroStrategy, and then select Configuration Wizard. The Welcome page opens.

8 Select the first option, Create Metadata, History List, and Statistics Repository Tables, as shown below. Then click Next.
9 Clear the **History List Tables** and **Statistics Tables** check boxes, leaving only the **Metadata Tables** check box selected, as shown below. Then click **Next**.

![Configuration Wizard](image)

10 From the **DSN** drop-down list, select the DSN that you created above for your metadata repository, as shown in the sample image below. If your database requires a login and password, type the **User Name** and **Password** to connect to the database. Then click **Next**.

![Configuration Wizard](image)

11 Review the summary of the tasks that are to be completed, and click **Finish**. The system creates a metadata repository within your database.
When the process is complete, click **Close**. You are returned to the first page of the Configuration Wizard.

You have now created the metadata repository, which is a storage space for the objects you will use to create reports and other MicroStrategy components.

**To establish an Intelligence Server connection to the metadata repository**

Intelligence Server must be connected to the metadata to retrieve reporting objects. Use the following steps to define this connection.

12 If the Configuration Wizard is not open, from the **Start** menu, point to **Programs** (or **All Programs**), then **MicroStrategy**, and then select **Configuration Wizard**. The Welcome page opens.

13 Select **Configure Intelligence Server**, as shown below. Then click **Next**.

14 Select the same DSN that you created for your metadata repository from the **DSN** drop-down list, as shown below. If your database requires a
login and password, type the **User Name** and **Password** to connect to the database. Then click **Next**.

15 Use the default MicroStrategy administrator account to connect to the database, by typing **Administrator** as the **User Name**. The default account does not use a password, so keep the **Password** field blank, as shown in the sample image below. Click **Next**.

You can configure security in MicroStrategy at a later time. To configure MicroStrategy user accounts that help define the
security of your MicroStrategy system, see *Additional Security Configurations, page 159*.

16 On the Server Definitions page, in the **Name** field, type a name for this Intelligence Server or accept the default computer name. Leave the remaining default settings as shown below. Then click **Next**.
17 Select the **Start Intelligence Server when finished** check box, as shown below. Then click **Next**.

If you receive a message that the default port number is already in use, type a new port number in the **Port number** field. Contact your system administrator for guidance in selecting a port number.

18 Review the summary of the tasks that are to be completed, and click **Finish**. The system configures Intelligence Server. When the process is complete, click **Close**. You are returned to the first page of the Configuration Wizard. You have now connected MicroStrategy Intelligence Server to the metadata repository.

**To set up a project source that connects to the metadata repository through Intelligence Server**

Your projects need to connect to the metadata repository so they can access the reporting objects stored there. You connect your projects to the metadata by connecting a single project source - all projects created within that project source are then connected to that metadata.

19 If the Configuration Wizard is not already open, from the **Start** menu point to **Programs** (or **All Programs**), then **MicroStrategy**, and then select **Configuration Wizard**. The Welcome page opens.
20 Select **Create a Project Source**, as shown below. Then click **Next**.

21 Type a name for your new project source in the **Project Source Name** field, as shown in the sample image below.

22 Select the **MicroStrategy Intelligence Server (3 Tier)** option as shown above. Then click **Next**.
23 From the **MicroStrategy Intelligence Server Machine Name** drop-down list, select the computer name where Intelligence Server is installed, as shown in the sample image below. You can also type the computer name where Intelligence Server is installed. Then click **Next**.

Note the following:

- If you changed the default port number when you configured Intelligence Server above, type the new port number in the **Port number used by MicroStrategy Intelligence Server** field.

- You can keep the default setting for **Connection times out after (mins)**. This option determines how long a connection to a project source can be idle before the connection is ended.

24 Select an authentication method, as shown in the sample image below. If you are unsure which method to use, select Standard Authentication.
(For details about authentication and security in MicroStrategy, see the System Administration Guide.) Then click Next.

- Review the summary of the tasks that are to be completed, and click Finish. The system creates and configures your project source. When the process is complete, click Close. Then click Exit.

Configuring MicroStrategy Web

The following section contains steps to configure MicroStrategy Web. You use MicroStrategy Web to create a project with your data and design reports and dashboards that can be viewed on a computer or a mobile device.

Depending on your environment, you can either proceed directly to configuring MicroStrategy Web, or you may need to first set up your environment with Tomcat:

- If your environment is running on Windows XP with an IIS version that is earlier than 6.0, you must use the steps in this section to configure MicroStrategy Web Universal, before you move on to configuring MicroStrategy Web. For steps to install Tomcat if IIS is earlier than 6.0, see Installing Tomcat if IIS is earlier than 6.0, page 31.

- If your environment is not running on Windows XP with an IIS version earlier than 6.0, you can proceed to configure MicroStrategy Web. To proceed to configuring MicroStrategy Web, see Configuring MicroStrategy Web, page 34.
Installing Tomcat if IIS is earlier than 6.0

Perform the steps in this section if your environment is running on Windows XP with an IIS version that is earlier than 6.0.

MicroStrategy Web and MicroStrategy Mobile Server must be able to run on the same computer for this Suite product. MicroStrategy Mobile Server can only be deployed on a Windows XP environment with IIS, if IIS 6.0 or later is available. If your environment is using a version of IIS that is earlier than 6.0, you can use the steps below to install Apache Tomcat. Tomcat can then operate as your web server, instead of IIS, to support MicroStrategy Web and MicroStrategy Mobile Server.

The steps in this section involve 3rd-party software. For the most accurate and up to date information on these software tools, see the applicable company websites.

The high-level checklist for installing Tomcat and configuring Web Universal is below:

- Download, install, and configure the Java Development Kit (JDK) (for steps, see To download, install, and configure the JDK, page 31)
- Download, install, and configure Apache Tomcat (for steps, see To download, install, and configure Apache Tomcat, page 32)
- Configure MicroStrategy Web Universal (for steps, see To deploy MicroStrategy Web Universal, page 34)

Detailed steps for completing this checklist are below.

To download, install, and configure the JDK

1. Download the Sun JDK shell file from:


   Note the following:
   - You can download any 6.x version of the JDK. For a list of certified JDK versions, see the MicroStrategy Readme for MicroStrategy Web Universal.
   - The download site may contain a number of software options, including JRE, JDK, and Java SDK. Be sure you download a
developer kit (which may be termed JDK or SDK). Do not download only the JRE.

2 Double-click the downloaded JDK executable.

3 On the Welcome screen, click **Next**.

4 By default, the JDK is installed as part of your system’s Development Tools. Click **Development Tools** and note the folder location at the bottom. Keep all default settings.

5 Click **Next** to start the installation process.

6 If prompted, you can also install the JRE on your computer. Click **Next**.

7 When installation is completed, click **Finish**.

   • To verify that the JDK was installed, open Windows Explorer, navigate to the folder in which the JDK was installed, and check to be sure the JDK files are in place.

8 On your Windows desktop, right-click **My Computer** and select **Properties**.

9 On the Advanced tab, click **Environment Variables**.

10 Under System Variables, click **New** to create a new system variable.

11 In the **Variable Name** field, type **JAVA_HOME** (all in upper case).

12 In the **Variable Value** field, specify the destination folder where you installed the JDK above. For example, if the path to your JDK executable is `C:\jdk1.6.0_21\bin\java.exe`, then the value of your **JAVA_HOME** variable is `C:\jdk1.6.0_21`.

13 Click **OK** until you exit the Properties dialog box.

---

**To download, install, and configure Apache Tomcat**


   Instructions for downloading and installing Tomcat are also available on the Apache website, or in the RUNNING file available from the .zip file that you download.
2 Scroll to the Binary Distributions area and select the file to download. You should select the 32-bit Windows .zip file.

For a list of certified Tomcat versions, see the MicroStrategy Readme for MicroStrategy Web Universal.

3 Extract the files from the downloaded Tomcat .zip file into a folder on your hard drive. Provide a representative name for the folder, such as apache-tomcat-[version].

- In Windows Explorer, you can navigate to the extraction folder to verify that Tomcat was installed.

4 Open Notepad or another text editor.

5 In a text editor, access the folder where Tomcat was installed. Open the config folder, then open the tomcat-users.xml file.

6 Find the row displaying “<tomcat-users>”. Add the following entries immediately after this row, as shown in the image below:

```xml
<role rolename="manager"/>
<role rolename="admin"/>

<user username="admin" password="admin" roles="manager,admin"/>
```

7 Save the .xml file.
To deploy MicroStrategy Web Universal

1 In a web browser, access http://localhost:8080 to ensure that Tomcat is started.

2 Click Tomcat Manager, and log in using the credentials you specified when configuring Tomcat. For example, if you used the suggested code sample above in the `tomcat-users.xml` file, log in with the user name `admin` and the password `admin`.

3 In the War File to Deploy area, next to the Select WAR File to Upload field, click **Browse** and locate `MicroStrategy.war`. The default location for this file is `C:\Program Files\MicroStrategy\WebJSP`.

4 Click **Deploy**. The deployment process may take a few minutes.

5 Confirm that your deployment was successful by scrolling up to the Applications area.

6 You can now access MicroStrategy Web by clicking the MicroStrategy link in the Tomcat Manager, or by typing the following URL into your browser: http://localhost:8080/MicroStrategy/servlet/mstrWeb.

**Configuring MicroStrategy Web**

It is recommended that you configure MicroStrategy Web. You must configure MicroStrategy Web if you plan to:

- Create grid reports and graph reports using the MicroStrategy Web interface. For details on designing reports, see Chapter 3, *Designing Reports*.

- Use widgets (interactive visualizations) when designing grid and graph reports and dashboards to be displayed on mobile devices. Widgets are a common component of most dashboards. For images of and information
about these widgets, see *Defining a report for display on a mobile device, page 91*.

- Design mobile applications to be accessed from iPhone, iPad, or Android clients. For details on applications you can build in MicroStrategy Mobile, see *Creating a micro application for a mobile device, page 98*.

To make your projects available in MicroStrategy Web, you must first connect MicroStrategy Web to Intelligence Server. Use the steps below to connect MicroStrategy Web to Intelligence Server.

**Prerequisites**

- To support this connection, a web server such as Microsoft Internet Information Services (IIS) must be installed on the MicroStrategy Web computer. For details on this requirement, see *Software requirements and recommendations, page 6*.

---

**To connect MicroStrategy Web to MicroStrategy Intelligence Server**

1. From the **Start** menu, point to **Programs**, then **MicroStrategy**, then **Web**, then **Web Administrator**. The MicroStrategy Web Administrator page opens in your web browser, as shown in the sample image below.

   ![Web Administrator Page](image)

   If you deployed MicroStrategy Web Universal on Tomcat, you can access the Web Administrator by typing the following URL into a web browser: `http://localhost:8080/MicroStrategy/servlet/mstrWebAdmin`. Log in using the login credentials you specified when configuring Tomcat; the recommended credentials are `admin/admin`. 
2 In the **Add a server manually** field, type the name or IP address of your Intelligence Server.

   If your Intelligence Server is on the same computer as your web server, you can type `localhost` in the **Add a server manually** field.

3 Leave the default connection properties and click **Connect**. MicroStrategy Web attempts to connect to the Intelligence Server. When the connection is complete, the server is listed in the Web Administrator’s Connected Servers list.

**To connect to a project in MicroStrategy Web**

4 At the top of the Web Administrator page, click **MicroStrategy Web Home**. The MicroStrategy Web Home page opens, with a list of the projects available on this Intelligence Server.

   If you are using a new metadata configuration, the MicroStrategy Web Home page will not display any projects. Projects will be displayed after you complete *Chapter 2, Creating a MicroStrategy Project with Your Data*.

   The image below shows a typical MicroStrategy Web Home page displaying projects that are available if the sample projects, MicroStrategy Tutorial and the MicroStrategy Analytics Modules, were installed.

   ![MicroStrategy Web Home Page](image)

Once the MicroStrategy Web connection to Intelligence Server has been established, users can access MicroStrategy Web with just the URL for MicroStrategy Web, and they can log in with a MicroStrategy login and password (such as `administrator` with a blank password) to access the reports and dashboards available in the projects.
Connecting MicroStrategy Mobile Server

To make MicroStrategy projects available to your Mobile users on their mobile devices, you must first connect MicroStrategy Mobile to Intelligence Server. Use the steps below to connect MicroStrategy Mobile to Intelligence Server.

Prerequisites

- To support this connection, a web server such as Microsoft Internet Information Services (IIS) must be installed on the MicroStrategy Mobile server computer. For details on this requirement, see Software requirements and recommendations, page 6.

- If you are using the ASP.NET version of MicroStrategy Mobile Server, be sure you configure the IIS authentication settings for the Mobile Server application. Otherwise, certain reports and dashboards may display incorrectly or fail to execute. For details to configure IIS authentication, see the Administering MicroStrategy Mobile chapter in the MicroStrategy Mobile Design and Administration Guide.

To connect MicroStrategy Mobile to MicroStrategy Intelligence Server

1 From the Start menu, point to Programs (or All Programs), then MicroStrategy, then Mobile, then Mobile Server, then select Mobile Administrator. The MicroStrategy Mobile Administrator page opens in your web browser, as shown in the sample image below.
2 In the **Add a server manually** field, type the name or IP address of your Intelligence Server.

   If your Intelligence Server is on the same computer as your web server, you can type **localhost** in the **Add a server manually** field.

3 Leave the default connection properties and click **Connect**. MicroStrategy Mobile attempts to connect to the Intelligence Server. When the connection is complete, the server is listed in the Mobile Administrator’s Connected Servers list, as shown below.

   ![Connected Server List](image)

   You can easily generate a configuration file that can be sent to your users’ mobile devices; when users click the link to the configuration file, their devices are automatically configured to work with this Mobile Server. This easy-to-use interface is accessible from the **Mobile Configuration** link on the left side of the Mobile Administration page. For details on this process, see *Configuring the iPhone or iPad client app, page 39*.

After the MicroStrategy Mobile connection to Intelligence Server is established, you configure the mobile client app so that users can access the reports and dashboards available from their handheld devices:

- For details to configure an iPhone or iPad to access reports, dashboards, and projects, see *Configuring the iPhone or iPad client app, page 39*.

- For details to configure an Android device to access reports, dashboards, and projects, see *Configuring the Android client app, page 45*.

- For details to configure a BlackBerry to access reports, dashboards, and projects, see *Configuring the BlackBerry client app, page 50*. 
Configuring the Mobile client

Use the appropriate steps below, depending on whether you are configuring MicroStrategy Mobile on an iPhone or iPad, on an Android device, or on a BlackBerry.

Configuring the iPhone or iPad client app

Before a user can view your organization’s reports and dashboards in MicroStrategy Mobile, the client application on the iPhone or iPad must be configured to communicate with your Mobile Server and Intelligence Server.

The MicroStrategy Mobile App provides sample apps and reports hosted by a public MicroStrategy Mobile Server. Once the iPhone or iPad configuration steps below are completed, these same apps will no longer be available from the newly configured devices served by your Mobile Server. If you want to explore the sample apps first, do so before proceeding through the following configuration steps.

There are various methods to configure the MicroStrategy Mobile client application on an iPhone or iPad. The steps below use the method designed for configuring multiple iPhones or iPads at the same time. This method creates a configuration file in .xml format, containing configuration instructions. You create a URL for the configuration file, email the URL to your iPhone/iPad users, and users click the URL from their iPhones/iPads to automatically configure the client application on their iPhones/iPads.

Prerequisites

- You must connect the MicroStrategy Mobile Server to the Intelligence Server. For steps, see Connecting MicroStrategy Mobile Server, page 37.

To configure an iPhone client app

To create an iPhone configuration file

1 From the Start menu, point to Programs (or All Programs), then MicroStrategy, then Mobile, then Mobile Server, then select Mobile Web Administrator. The Mobile Server Administrator page opens.
2 Select **Mobile Configuration** from the menu on the left. The Mobile Configuration page opens, as shown below.

3 Click **Define New Configuration**. The Device drop-down list is displayed.

4 Select the device type for which you will create a configuration. Then click **OK**. The Mobile Configuration page opens, as shown below.

5 In the **Configuration Name** field, type a name for this set of configuration settings you will be selecting. This is the name that is displayed in the configuration list.

6 On the **iPhone Settings** tab or the **iPad Settings** tab, retain the default settings. For details on these settings, see the *Administering MicroStrategy Mobile* chapter in the *MicroStrategy Mobile Design and Administration Guide*.

**To configure connectivity settings**

7 Select the **Connectivity Settings** tab. Under Default Mobile Server Authentication, you specify the default authentication settings for the
Mobile Server. These settings are used by the client application on an iPhone/iPad to connect to any Mobile Server that has these settings applied to it.

8 From the Authentication Mode drop-down list, select the default Mobile Server authentication mode to use. If the Mobile Server will be configured to use default authentication settings and no login or password will be required, you can leave this setting as Anonymous.

9 Type a Login and Password. The login name is the name to be used by the client application to log into the Mobile Server that will be selected below.

   • If you selected Anonymous authentication above, no login or password is required and these fields can be left blank.

10 Click the Configure New Mobile Server link.

11 In the Mobile Server Name field, type the name of the Mobile Server that the client application will connect to.

   Alternatively, you can type the IP address to identify the Mobile Server to connect to. Your administrator can show you how to retrieve the computer’s IP address.

12 In the Mobile Server Port field, type the port number that is used by the Mobile Server. If the Mobile Server is running on IIS, the default value is 80.

13 In the Mobile Server Path field, type the path to the Mobile Server. If the Mobile Server is running on IIS, the default path is MicroStrategyMobile, as specified above in To define MicroStrategy’s virtual directories, page 15.

14 From the Mobile Server Type drop-down list, select ASP.NET for MicroStrategy Mobile, or J2EE for MicroStrategy Mobile Universal.

15 From the Request Type drop-down list, specify whether you use HTTP (no encryption) or HTTPS (HTTP encryption enabled) to access the Mobile Server. For steps to configure Mobile Server to use HTTPS (SSL), see the Administering MicroStrategy Web and Mobile in the MicroStrategy System Administration Guide.
16 If you specified Anonymous authentication for the Authentication Mode above, you can select the **Use Default Authentication** check box. Otherwise, specify the Mobile Server authentication information:

a. From the Mobile Server’s **Default Authentication Mode** drop-down list, select the type of authentication to use for the Mobile Server.

b. In the **Login** field, type the login name to be used by the client application to access the Mobile Servers that will use these default authentication settings.

c. In the **Password** field, type the password for that login name.

17 Under Default Project Authentication, you specify settings that are used by the client application on the iPhone/iPad to log into any project that is specified below to use the default project authentication.

a. From the **Authentication Mode** drop-down list, select the type of authentication used by the Intelligence Server.

b. In the **Login** field, type the MicroStrategy login name to be used by the client application on the iPhone/iPad to log into the Intelligence Server.

c. In the **Password** field, type the password for that login name.

**To configure access to a MicroStrategy project**

If you have installed any of the sample projects that come with MicroStrategy (the Tutorial project or any of the Analytics Modules projects, such as the Customer Analysis Module project, the Financial Reporting Analysis Module project, and so on), you can use the following steps to configure access to the sample reports and dashboards contained in those projects.

If you did not install any sample projects and have not yet created your own project, skip these substeps and continue configuration with *To configure the client app’s Home screen* below. You can return to these substeps and complete them after you have created your own project in *Chapter 2, Creating a MicroStrategy Project with Your Data*.

18 Click the **Configure New Project** link.

19 From the **Project Names** list, select the project to access.

20 To use the default project authentication settings specified above, select the **Use Default Authentication** check box. Otherwise, specify the project authentication settings as specified above.
By default, the iPhone/iPad client app will allow users to access MicroStrategy Web’s Shared Reports folder, a default folder that contains sample reports and dashboards out of the box. However, if you want to designate a different MicroStrategy folder for users to access automatically from their iPhones/iPads, type the folder name in the Root Folder field.

To configure the client app’s Home screen

Select the Home Screen tab.

The default Home screen that comes with MicroStrategy’s iPhone app is shown below.

The default Home screen displays buttons to access the following:

- **Reports**: Tap this to display all the reports and dashboards that the user has a MicroStrategy subscription to.

- **Shared Libraries**: Tap this to display the MicroStrategy projects that a user’s iPhone or iPad connects to. Tapping a project displays the folders within it. Tapping a report or dashboard in a folder runs the report/dashboard.

- **Settings**: Tap this to change login information, server information, and various display options for the app.

- **Help**: Tap this to open the Help file.

Select **Display the default home screen** to have this screen displayed automatically when users start the MicroStrategy app on their iPhones or iPads. For information to create a custom home screen, see the
Get Started with the MicroStrategy Suite


1 Administering MicroStrategy Mobile chapter in the MicroStrategy Mobile Design and Administration Guide.

23 Click **Save**. The configuration file is saved as an .xml file containing the settings that you selected.

Next you must generate a URL for the link that users will click from their iPhones or iPads to launch the automated configuration.

---

**To generate a URL for a configuration**

1 On the MicroStrategy Mobile Server page, select **Mobile Configuration** from the menu on the left. The Mobile Configuration page opens.

2 From the Actions area on the right, click the **Generate URL** icon next to the configuration you want to generate a URL for. The Generate Configuration URL page opens.

3 From the **Authentication Mode** drop-down list, select an authentication mode required for accessing the Mobile Server from an iPhone. When the user taps the URL on the iPhone/iPad, the user is prompted to enter a login and password so the iPhone/iPad app can log into the Mobile Server using this authentication mode.

4 In the **Server Name** field, type the name of the computer that is hosting the Mobile Server that the configuration is stored on. Do not use Local Host in this field.

5 By default, the port number used by Mobile Server is included in the URL.

   • If you do not want to include the port number in the URL, for example, in an ASP.NET environment, clear the **Include port** check box.

   • If you are including the port number in the URL, type the port number for the Mobile Server in the **Host Port** field. The default port number is 80.

6 Click **Generate URL**. The URL is generated and displayed. You can copy and paste the URL into an email and send it to a mobile device user.

7 To save the URL settings, click **Save**. The dialog box closes, and the authentication mode and host information are saved for the next time you generate a URL for this set of configuration settings.
To complete the iPhone or iPad client configuration

1 From the iPhone or iPad, tap the emailed URL that was generated and sent above.

The MicroStrategy iPhone or iPad client app automatically sets itself up using the settings from the configuration. The iPhone/iPad user can run reports and dashboards hosted by your Mobile Server. For details to run and navigate through reports and dashboards, see Analyzing reports and dashboards from an iPhone, page 127.

Configuring the Android client app

Before a user can view your organization’s reports and dashboards in MicroStrategy Mobile, the client application on the Android device must be configured to communicate with your Mobile Server and Intelligence Server.

The MicroStrategy Mobile App provides sample apps and reports hosted by a public MicroStrategy Mobile Server. Once the Android device configuration steps below are completed, these same apps will no longer be available from the newly configured devices served by your Mobile Server. If you wish to explore the sample apps first, do so before proceeding through the following configuration steps.

There are various methods to configure the MicroStrategy Mobile client application on an Android device. The steps below use the method designed for configuring multiple Android devices at the same time. This method creates a configuration file in .xml format, containing configuration instructions. You create a URL for the configuration file, email the URL to your Android users, and users click the URL from their Android devices to automatically configure the client application on their Android devices.

If you are using a different operating system or need more details on any of the options described, see the MicroStrategy Mobile Design and Administration Guide.

Prerequisites

- You must connect the MicroStrategy Mobile Server to the Intelligence Server. For steps, see Connecting MicroStrategy Mobile Server, page 37.
To configure an Android client app

To create an Android configuration file

1 From the Start menu, point to Programs (or All Programs), then MicroStrategy, then Mobile, then Mobile Server, then select Mobile Administrator. The Mobile Server Administrator page opens.

2 From the pane on the left, select Mobile Configuration. The Mobile Configuration page opens, as shown below.

3 Click Define New Configuration. The Create Configuration page opens.

4 From the Device drop-down list, select either Android Phone or Android Tablet to create a configuration for the desired device.

5 In the Configuration Name field, type a name for this set of configuration settings you will be selecting. This is the name that is displayed in the configuration list.

6 On the Phone Settings tab or the Tablet Settings tab, retain the default settings. For details on these settings, see the Administering MicroStrategy Mobile chapter in the MicroStrategy Mobile Design and Administration Guide.

To configure connectivity settings

7 Select the Connectivity Settings tab.

8 From the Authentication Mode drop-down list, select the default Mobile Server authentication mode to use. If the Mobile Server will be configured to use default authentication settings and no login or password will be required, you can leave this setting as Anonymous.
9 Type a Login and Password. The login name is the name to be used by the client application to log into the Mobile Server that will be selected below.

- If you selected Anonymous authentication above, no login or password is required and these fields are not displayed.

10 Click the Configure New Mobile Server link.

11 In the Mobile Server Name field, type the name of the Mobile Server that the client application will connect to.

Alternatively, you can type the IP address to identify the Mobile Server to connect to. Your administrator can show you how to retrieve the computer's IP address.

12 In the Mobile Server Port field, type the port number that is used by the Mobile Server. If the Mobile Server is running on IIS, the default value is 80.

13 In the Mobile Server Path field, type the path to the Mobile Server. If the Mobile Server is running on IIS, the default path is MicroStrategyMobile, as specified above in To define MicroStrategy's virtual directories, page 15.

14 From the Mobile Server Type drop-down list, select ASP.NET for MicroStrategy Mobile, or J2EE for MicroStrategy Mobile Universal.

15 From the Request Type drop-down list, specify whether you use HTTP (no encryption) or HTTPS (HTTP encryption enabled) to access the Mobile Server. For steps to configure Mobile Server to use HTTPS (SSL), see the Administering MicroStrategy Web and Mobile in the MicroStrategy System Administration Guide.

16 If you specified Anonymous authentication for the Authentication Mode above, you can select the Use Default Authentication check box.

17 Under Default Project Authentication, you specify settings that are used by the client application on the device to log into any project that is specified below to use the default project authentication.

a From the Authentication Mode drop-down list, select the type of authentication used by the Intelligence Server.

b In the Login field, type the MicroStrategy login name to be used by the client application on the Android to log into the Intelligence...
Server. (If you selected Windows authentication above, no login or password is required.)

c In the **Password** field, type the password for that login name.

**To configure access to a MicroStrategy project**

If you have installed any of the sample projects that come with MicroStrategy (the Tutorial project or any of the Analytics Modules projects, such as the Customer Analysis Module project, the Financial Reporting Analysis Module project, and so on), you can use the following steps to configure access to the sample reports and dashboards contained in those projects.

If you did not install any sample projects and have not yet created your own project, skip these substeps and continue configuration with **To configure the client app’s Home screen** below. You can return to these substeps and complete them after you have created your own project in *Chapter 2, Creating a MicroStrategy Project with Your Data*.

18 Click the **Configure New Project** link.

19 From the **Project Name** list, select the project to access.

20 To use the default project authentication settings specified above, select the **Use Default Authentication** check box. Otherwise, specify the project authentication settings as specified above.

**To configure the client app’s Home screen**

21 Select the **Home Screen** tab.

The default Home screen displays buttons to access the following:

- **Shared Libraries**: Tap this to display the MicroStrategy projects that a user’s Android device connects to. Tapping a project displays the folders within it. Tapping a report or dashboard in a folder runs the report/dashboard.

- **Settings**: Tap this to change login information, server information, and various display options for the app.

- **Help**: Tap this to open the Help file.

Select **Display the default home screen** to have this screen displayed automatically when users start the MicroStrategy app on their Android phones or tablets. For information to create a custom home screen, see the *Administering MicroStrategy Mobile* chapter in the *MicroStrategy Mobile Design and Administration Guide*. 
22 Click Save. The configuration file is saved as an .xml file containing the settings that you selected.

Next you must generate a URL for the link that users will click from their Androids to launch the automated configuration.

To generate a URL for a configuration

1 On the MicroStrategy Mobile Server page, select Mobile Configuration from the menu on the left. The Mobile Configuration page opens.

2 From the Actions area on the right, click the Generate URL icon next to the configuration you want to generate a URL for. The Generate Configuration URL page opens.

3 In the Server Name field, type the name of the computer that is hosting the Mobile Server that the configuration is stored on. Do not use Local Host in this field.

4 By default, the port number used by Mobile Server is included in the URL.

   • If you do not want to include the port number in the URL, for example, in an ASP.NET environment, clear the Include port check box.

   • If you are including the port number in the URL, type the port number for the Mobile Server in the Host Port field. The default port number is 80.

5 Click Generate URL. The URL is generated and displayed. You can copy and paste the URL into an HTML file, thus embedding the link in the HTML file. Then send the HTML file’s URL to your Android users.

6 To save the URL settings, click Save. The dialog box closes, and the authentication mode and host information are saved for the next time you generate a URL for this group of configuration settings.

To complete the Android client configuration

1 From the Android phone or tablet, tap the emailed URL that was generated and sent above.
The MicroStrategy Android client app automatically sets itself up using the settings from the configuration. The Android user can run reports and dashboards hosted by your Mobile Server.

**Configuring the BlackBerry client app**

After installing the MicroStrategy Mobile BlackBerry client, you must configure it so that it can communicate with your MicroStrategy system.

The BlackBerry Enterprise Server (BES) enables you to set an IT policy for its client applications. With this IT policy, you can configure all the client devices at one time. If you want to use an IT policy, details on the MicroStrategy Mobile settings for a BlackBerry client IT policy are in the *Administering MicroStrategy Mobile* chapter in the *MicroStrategy Mobile Design and Administration Guide*. For details to deploy an IT policy over the BES, see your BES documentation.

**Prerequisites**

- You must connect the MicroStrategy Mobile Server to the Intelligence Server. For steps, see *Connecting MicroStrategy Mobile Server, page 37*.

The steps below show you how to configure the Mobile client from the Preferences screen on the BlackBerry smartphone. You add connection information for the Mobile Server, and then you configure the MicroStrategy project from which the BlackBerry will receive reports. For alternative methods to configure a BlackBerry client with MicroStrategy Mobile, see the *Administering MicroStrategy Mobile* chapter in the *MicroStrategy Mobile Design and Administration Guide*.

---

**To configure MicroStrategy Mobile for BlackBerry**

1. On the BlackBerry smartphone, open the MicroStrategy Mobile application.
2. Click and select Preferences. The Preferences screen opens.
3. Scroll to the Mobile Servers Configured area.
Enter the information for each option, as described below:

- **Name**: The DNS name or IP address of the Mobile Server.
- **Port**: The port number used by the Mobile Server.
- **Path**: The path on which the Mobile Server is installed.
- **Type**: Select **ASP.NET** if you have installed the MicroStrategy Mobile product, or select **J2EE** if you have installed the MicroStrategy Mobile Universal product.
- **Request Type**: Select **HTTP** if your environment uses no encryption or **HTTPS** if your environment uses SSL encryption.

To use the default authentication mode and credentials for the Mobile Server, select the **Use Default** check box under Authentication.

The default authentication mode is set on the Preferences screen under Default Mobile Server Authentication. By default, MicroStrategy Mobile uses standard MicroStrategy authentication to identify the user logging into projects on the Mobile Server. You can use any supported form of authentication to log into the Mobile Server; for details on authentication modes, see the *Setting Up User Security* chapter in the *MicroStrategy System Administration Guide*.

To use a different authentication mode, follow the steps below:

a. Under Authentication, clear the **Use Default** check box.

b. Scroll to the Authentication Mode area, then click and select the type of authentication to use.

c. In the **Login** field, type the login name to be used by the BlackBerry application to log into the MicroStrategy project.

d. In the **Password** field, type the password for the login name above.

Scroll to Default Project Authentication. These options determine the default authentication mode for all projects configured for this Mobile Server. Enter information for each option, as described below:

- **Mode**: Select an authentication mode.
- **Login**: Type the login name that you use to access the Mobile Server.
- **Password**: Type the password for the login name above.

Click and select **Close**. The Mobile Server Setup screen closes.
9 Click and select **Save**. The Mobile Server information is saved.

Once you have configured the Mobile Server, you must provide information about the projects that contain the reports and dashboards you are subscribed to.

---

**To configure a project for MicroStrategy Mobile for Blackberry**

If you installed any of the sample projects that come with MicroStrategy (the Tutorial project or any of the Analytics Modules projects, such as the Customer Analysis Module project, the Financial Reporting Analysis Module project, and so on), you can use the following steps to configure access to the sample reports and dashboards contained in those projects.

If you did not install any sample projects and have not yet created your own project, skip these steps and close and save your configuration. You can return to these steps and complete them after you have created your own project in *Chapter 2, Creating a MicroStrategy Project with Your Data*.

1 On the BlackBerry smartphone, open the MicroStrategy Mobile application.

2 Click and select **Preferences**. The Preferences screen opens.

3 Scroll to Mobile Servers Configured and highlight the Mobile Server to which you want to add a MicroStrategy project.

4 Click and select **Edit Mobile Server**. The Mobile Server Setup screen opens.

5 Scroll to Projects Configured, then click and select **Add Project**. The Project Setup screen opens.

6 Enter information for each option, as described below:

   • **Project Name**: The name of the MicroStrategy project. This field is case-sensitive.

   • **Server Name**: The DNS name or IP address of the Intelligence Server that contains the project.

   • **Server Port**: The port number for the Intelligence Server.

7 To use the default authentication mode and login credentials for the project, select the **Use Default** check box under Authentication.
To use a different authentication mode, use the steps provided below:

a  Under Authentication, clear the Use Default check box.

b  Scroll to the Authentication Mode area, then click and select the type of authentication to use for the project.

c  In the Login field, type the login name to be used by the BlackBerry application to log into the MicroStrategy project.

d  In the Password field, type the password for the login name above.

8  Click and select Close. The Project Setup screen closes and the project is now listed under Projects Configured.

9  Click and select Close again. The Mobile Server Setup screen closes.

10 Click and select Save. The project configuration information is saved.

Now that you have completed the configuration of the MicroStrategy Suite, you can begin to create your MicroStrategy project. The steps to connect to your data source and create a MicroStrategy project are described in Chapter 2, Creating a MicroStrategy Project with Your Data.
Introduction

To create mobile BI reports, dashboards, and workflows, and to support your overall reporting environment, you must integrate your data into MicroStrategy. This chapter describes how to integrate your data into a MicroStrategy project, which contains your reports and reporting objects. Use these steps to jump-start your MicroStrategy project.

About projects, attributes, facts, metrics, and hierarchies

You create a project by mapping physical data structures from your data source (the tables and columns in which your data is stored) to your MicroStrategy metadata repository. Then you can create reporting objects and reports based on your physical data. The reporting objects and reports that you create are stored in the metadata repository. You use MicroStrategy Architect to create projects.
The basic objects required for any reporting project are attributes, facts, and hierarchies. A description of each object type is provided here. You can reference this list as you proceed to create objects in the steps below:

• Attributes: An attribute provides context to your business calculations. For example, the Year attribute can give your data meaning. A long list of revenue data is not helpful unless it is displayed in the context of time (for example, revenue last year), geographical region, business unit, or product line. When designing reports, you place attributes on a report to tell MicroStrategy to use the column of data in your data source that is associated with that attribute. MicroStrategy can then display the related data on that report.

• Attribute forms: Attribute forms provide more descriptive information on attributes. Attribute forms are mapped to columns in your data source. For example, a Customer attribute requires attribute forms to provide customer first names, last names, email addresses, gender, and so on. This information is often stored in a data source as columns that contain descriptive information.

• Facts: A fact is a piece of your data that is numerical and can be calculated, for example, revenue, profit, or cost. Facts are combined with mathematical operators and other facts to create metrics. When designing reports, you place metrics on a report. Including a metric on a report tells the system to locate the column of data in your data source that is associated with the fact or facts used to define the metric. MicroStrategy can then calculate and display the related data on that report.

• Metrics: A metric is made up of facts. A metric is a MicroStrategy object that represents business performance and key performance indicators (KPIs). From a practical perspective, when a metric is placed on a report, metrics display calculations performed on data stored in your data source. Metrics operate similar to formulas in spreadsheet software. A metric provides the numbers you see on a report.

• Hierarchies: A hierarchy is a group of conceptually related attributes. Common hierarchies in a retail organization might include Time (made up of attributes such as Day, Month, Year); Geography (made up of attributes such as Store, State, Region, Country); or Product (made up of attributes such as Item, Subcategory, Category.) It is easier for report designers to locate appropriate attributes to use on reports if those attributes are grouped together in the project in a logical way that makes sense for your business goals.

For example, if many reports will contain a time-related attribute so that reports can display week, month, year, or all three, then it makes sense to include all time-related attributes in a single group. These groups, used
for attribute browsing purposes, are called hierarchies. When the report
designer browses for objects to place on a report, the designer can open a
folder for the Time hierarchy to see and use all attributes related to time.

Creating a project, attributes, facts, and hierarchies

Use the following high-level checklist to create a project, attributes, facts,
and hierarchies. Steps for each high-level task follow the checklist.

High-level checklist to create a project, attributes, facts, and hierarchies

• Create a DSN to connect to your data source. Your data source contains
the information for your business in the data source of your choice. This
can be a Microsoft Access database, Microsoft Excel spreadsheet, or some
other database or data source. For steps, see Creating a DSN to connect
to your data source, page 58.

• Create a database instance that tells the MicroStrategy Suite how to
connect to and access your data source. Database instances are
MicroStrategy objects that use the DSN you created to connect to a
database or other data source. For steps, see Creating a database
instance to access your data source, page 60.

• Create a MicroStrategy project that will contain your reports and
reporting objects. For steps, see Creating a project to contain reports
and report objects, page 63.

• Create the objects required to design reports and dashboards in your
project, using MicroStrategy Architect. For steps, see Creating attributes,
facts, and hierarchies, page 67.

While performing the steps below, if you encounter a scenario with your data
or environment that requires some special handling, see the MicroStrategy
Project Design Guide for complete details related to project, attribute, fact,
and hierarchy design and creation.
Creating a DSN to connect to your data source

Establishing communication between MicroStrategy and your databases, Microsoft Excel spreadsheets, or other data sources is an essential first step in configuring a MicroStrategy project for reporting and analysis of your data.

Prerequisites

- You must have a data source that contains the information for your business. This can be a Microsoft Access database, Microsoft Excel spreadsheet, or some other database or data source.

For information on preparing a Microsoft Excel spreadsheet for use as a data source in MicroStrategy, see the Connect to Excel files section in the Advanced Reporting Guide.

To create a DSN to connect to your data source

1. On the computer where MicroStrategy Desktop is installed, from the Start menu, point to Programs (or All Programs), then MicroStrategy, then Tools, and then select Connectivity Wizard. The Welcome page opens.

2. Click Next. A list of database drivers is displayed, as shown below. Users of the MicroStrategy platform can select the appropriate certified,
MicroStrategy-branded ODBC driver to connect MicroStrategy products to various databases and other data sources.

3 Select a database driver with which to create a DSN, using one of the options below:

- For a Microsoft Access database or a Microsoft Excel spreadsheet, select Other Relational Databases and click Next. Select the appropriate database driver and click Next. Options to define the connection to your Access or Excel data source are displayed. Complete the required information and click OK to create the DSN. Proceed to Creating a database instance to access your data source, page 60.

- For a database listed in the database driver options, such as PostgreSQL or Microsoft SQL Server, select the appropriate database driver for your data source and click Next. The Driver Details page opens.

- For a database that is not listed in the database driver options, select Other Relational Databases and click Next. This allows you to select from all database drivers installed on your system. Select the appropriate database driver and click Next.

4 Complete the information in the appropriate fields for connecting with the selected database driver to your data source which stores your data...
warehouse. The information to enter varies depending on the database platform on which you are installing the MicroStrategy software.

Ensure that you provide a descriptive name for the DSN so that you can distinguish it from the DSN you created for the MicroStrategy metadata.

5 Click **Test** to verify the connection. The Test Connection dialog box opens.

6 If your database requires a login and password, type the **User Name** and **Password** to connect to the database.

7 Click **Connect** to test and verify the connection. If the test is successful, the connection with the database is established. If the test fails, verify the correct connection information with your database administrator and make any required changes to the information you provided in the previous steps.

8 Click **Close**, and then **Finish** to create the new DSN.

**Creating a database instance to access your data source**

You must create a database instance that tells the MicroStrategy Suite how to connect to and access your data source. Database instances use the DSN you created above to connect to a database or other data source.

**To create a database instance to access your data source**

1 Open MicroStrategy Desktop. To do this, from your **Start** menu, select **Programs** (or **All Programs**), then **MicroStrategy**, then **Desktop**, then select **Desktop** again.

2 Right-click your project source where it is listed in the Folder List on the left and select **Connect to Project Source** to log in to your project source. Use the default MicroStrategy administrator account by typing **Administrator** as the **User Name**. The default account does not use a password, so keep the **Password** field blank, as shown in the sample image below.

If you have installed the MicroStrategy Tutorial or the MicroStrategy Analytics Modules projects, additional project sources may be displayed. Log in to the project source you created.
A message is displayed that no projects are available. Click **OK** to close this message, as you will create a project using the steps below.

4 In Desktop, with your project source expanded in the Folder List, expand **Administration**, then expand **Configuration Managers**, and select **Database Instances**.
5 Right-click in any empty space on the right, and select **Database Instance Wizard**, as shown below:

6 In the Database Instance Wizard, click **Next**.

7 Define the connection between the MicroStrategy Suite and your data source:
   
a In the **Name** field, type a name for the database instance. This name will identify the Suite connection to your data source. For example, you can type the name MicroStrategy Suite.

b From the **Database Type** drop-down list, select the type of database you use to store your data, as shown below.
– If your database is not listed, select the **Generic** database type.

![](image)

8 Select the DSN that defines the connection information to the data source that contains your data warehouse. Use the DSN you created in *Creating a DSN to connect to your data source, page 58*. Then type credentials in the **Database login information** fields:

- If your database requires database login credentials, type the user name and password for an account that has access to the database and database tables. Contact your database administrator for database login credentials.

- If your database does not require database login credentials, you can type any user name and leave the password blank.

9 Click **Next**. Then click **Finish**. Your new database instance is created and displayed in Desktop.

Now that you have MicroStrategy connected to your data source, you can create your MicroStrategy project.

**Creating a project to contain reports and report objects**

Next you create a MicroStrategy project that will contain your reports and reporting objects.
To create a project to contain your MicroStrategy reports and reporting objects

1. If you need to log in again, in MicroStrategy Desktop, log in to the project source you created in To set up a project source that connects to the metadata repository through Intelligence Server, page 27.

2. In Desktop, from the Schema menu, select Create New Project. The Project Creation Assistant opens.

3. Click Create Project. The New Project dialog box opens.

4. Type a name and description for your new project, as shown below. Then click OK. The New Project dialog box closes and your new project is created. You now have the foundation built for your project.
5 In the Project Creation Assistant, click **Architect**, as shown below:

Do not click **Select tables from the Warehouse Catalog**. The steps below show you how to add tables to your project using Architect.

The Warehouse Database Instance dialog box opens.

6 Use the drop-down list to select the database instance which you created in *To create a database instance to access your data source, page 60*. This is the main source of data for your MicroStrategy application, as shown in the example below.
7 Once you have selected the database instance, click **OK**. MicroStrategy Architect opens.

8 Click the **Architect** button 🎨 and select **Settings**. The MicroStrategy Architect Settings dialog box opens. Select the following options:

   a On the **Configuration** tab, select the **Update schema after closing Architect** check box.

   b On the **Metric Creation** tab, select the aggregation functions used to automatically create metrics when a fact is created for a project. A separate metric is created to support each aggregation of a fact. You can allow the automatic creation of metrics using the aggregation functions listed below:

   - **Avg**: Create metrics automatically that perform an average calculation on the fact expression.
   - **Sum**: Create metrics automatically that perform a summation calculation on the fact expression.
   - **Count**: Create metrics automatically that perform a count calculation on the fact expression.
   - **Min**: Create metrics automatically that perform a minimum calculation on the fact expression.
   - **Max**: Create metrics automatically that perform a maximum calculation on the fact expression.
   - **Var**: Create metrics automatically that perform a variance calculation on the fact expression.

   The metrics are created in the **Public Objects/Metrics** folder of a MicroStrategy project.

   c To determine metric naming conventions, click **Advanced Options**. The Advanced Options dialog box opens. When a metric is created for an aggregation function, the metric naming convention for that aggregation function is used to define the name for the metric. Click **OK** to save any changes you make to metric naming conventions.

   d The remaining options in the MicroStrategy Architect Settings dialog box define how Architect displays data, maps schema objects, and loads the Warehouse Catalog. Click **OK** to accept the default settings for these options.
9 In MicroStrategy Architect, from the Home tab, in the View area, click the Logical View icon, as shown below.

In the View area, click the arrow icon at the bottom right. The Advanced Options dialog box opens.

10 Select the following check boxes:
   • Display available columns on logical tables
   • Display used columns on logical tables
   • Display attribute forms on logical tables

11 Click OK. The Advanced Options dialog box closes.

12 On the Design tab, in the Auto Recognize area, click the arrow icon at the bottom right, as shown in the image below.

The Automatic Schema Recognition dialog box opens. Select the Auto recognize option. This option automatically defines how attributes and facts are created when tables are added to the project using Architect, based on column names and data types. For complete information on how to define these options to create and map attributes, see the Project Design Guide.

13 Click OK. The Automatic Schema Recognition dialog box closes.

Creating attributes, facts, and hierarchies

Now you create the objects required to design reports and dashboards in your project, using MicroStrategy Architect. MicroStrategy Architect provides Undo and Redo options to make object creation easier.
At any point during project creation, you can save your progress and come back to MicroStrategy Architect later to continue creating objects. To save your progress, and then log back into your project later:

a. Click the **Save** icon on the toolbar to save your progress.
b. To close Architect, click the **Architect** icon and select **Close**. The Schema Update dialog box opens.
c. Ensure that the check boxes are all selected and click **Update**.
d. Select **OK** to close the Project Creation Assistant.
e. To re-open MicroStrategy Architect to continue creating objects in your project, in MicroStrategy Desktop, log in to the project, and from the **Schema** menu, select **Architect**.

### Creating attributes and facts

You can now begin to create attributes, facts, and hierarchies for your project using MicroStrategy Architect. For a definition and examples of attributes, facts, and hierarchies, see *About projects, attributes, facts, metrics, and hierarchies, page 55*.

MicroStrategy Architect can automatically create metrics when facts are added to your project. For a definition and examples of metrics, see *About projects, attributes, facts, metrics, and hierarchies, page 55*.

**To create and add attributes and facts to your project**

1. On the left side of MicroStrategy Architect, expand your new database instance. All the tables that contain your data in your data source are
displayed on the left, as shown in the example image below. This is a live view into your data source.

2 On the left, identify the tables that contain data that you want to include in your MicroStrategy project.

For example, to create reports that show sales data, choose tables that store sales data. To report on sales by month, quarter, and year, you must also choose tables that contain dates when sales transactions occurred. If you are unsure which data you need, you might benefit from choosing all available tables.

3 Click and drag the tables you need from the left, and drop them onto the pane in the center. You can select multiple tables by holding CTRL or SHIFT while clicking the tables.
As you drop the tables onto the pane in the center, a Results Preview dialog box opens, as shown below.

4 The Attribute tab and the Fact tab of this Results Preview dialog box display the attributes and facts that can be created automatically for the tables selected, based on schema creation rules (heuristics). (For a definition and examples of attributes, see About projects, attributes, facts, metrics, and hierarchies, page 55.) To create an attribute or fact automatically, select its associated check box.

• Clearing a check box for an attribute or fact excludes that attribute or fact from the automatic creation process.

5 When Architect creates attributes and facts automatically, the names of the objects are determined by the column names that store your data in your data source. To rename an attribute or fact to better reflect your data, right-click the attribute or fact within a table that you have added to the project, and select Rename. Type a new name for the object and click OK.

6 Once you have selected the attributes and facts that are to be automatically created for the tables, click OK. The tables are displayed
along with column names from within each table, as shown in the example below:

Notice in the example above that facts and attributes have been created based on schema creation heuristics. Yellow block icons are displayed to represent attributes, while icons displaying the # symbol are displayed to represent facts.

For details on identifying data that is useful to become an object in the project, see *The Context of Your Business Data: Attributes* and *The Building Blocks of Your Business Data: Facts* chapters in the *Project Design Guide*. For further explanation of standard schema creation rules and how to define them, see the *Creating a Project Using Architect* chapter of the *Project Design Guide*.

**To create attributes and attribute forms**

For a definition and examples of attributes and attribute forms, see *About projects, attributes, facts, metrics, and hierarchies*, page 55.
When you have finished dragging all the tables that you need, if some columns of data still need to be mapped to attributes, you can create attributes manually:

a Right-click a column name that contains data to make available in the project as contextual information, and select Create Attribute as shown below. The Properties pane is displayed on the right.

- Attributes can be created based on an ID column, which defines the individual elements of each attribute. An ID column contains unique values which are commonly numeric values such as 1, 2, 3, and so on. When choosing the ID column to create an attribute, make sure that all values in the column are unique and that it does not contain NULL values. You should never use a column that has NULL or repeated values as the ID column for an attribute. Doing so results in unexpected behavior and errors.

b In the Properties pane, type a name for the attribute. This is the name report designers and business users will see, so be sure that it makes sense to others. Repeat this until you have created attributes for all the columns of data that you need.

Once attributes are created, you can create attribute forms for the attributes to display additional information. To add a column as an attribute form of an attribute, select an available column in a table, then drag it onto an attribute within the same table, as shown in the
step-by-step images below. A new attribute form is created for the attribute.

To create facts

For a definition and examples of facts, see About projects, attributes, facts, metrics, and hierarchies, page 55.

You can identify columns to create facts using the following best practices:

- A fact has two characteristics: It is numeric, and it can be aggregated. Examples of common facts include sales dollars, units sold, profit, and cost. If you belong to the Human Resource department, you may want to include facts such as tenure and compensation cost.

- Facts are created automatically based on standard schema creation rules (heuristics), which use column names and data types to automatically create facts. For further explanation of these rules and how to manually define them, see the Creating a Project Using Architect chapter of the Project Design Guide.

In MicroStrategy Architect, ensure that you are still in the Project Tables View to identify columns in your warehouse tables on the left that contain...
data suitable to become a fact. Once you have identified data that should be mapped to facts, you can create facts manually as described below:

- If all the facts for your project are created successfully using the automatic schema creation rules (heuristics), continue to *Defining attribute relationships and creating hierarchies, page 74.*

- If a column is created as a fact that does not fit your reporting needs, right-click the fact and select *Remove.*

- If some columns of data still need to be mapped to facts, you can create facts manually:
  
  a Right-click a column name that contains data to make available in the project as a fact, and select *Create Fact* as shown below.

  b For detailed examples of how to identify and create facts, see *The Building Blocks of Business Data: Facts* chapter in the *Project Design Guide.*

**Defining attribute relationships and creating hierarchies**

A hierarchy is a group of conceptually related attributes. The MicroStrategy Suite uses attribute relationship information to determine how to combine and calculate data on reports, and to provide a logical path to navigate through the data on a report.

It is easier for report designers to locate appropriate attributes if those attributes are grouped together in a logical way. For example, when the report designer browses for objects to place on a report, the designer can open a folder for the Time hierarchy to see and use all attributes related to time, such as Month, Day, or Year.
To define attribute relationships and create hierarchies

1. In MicroStrategy Architect, click the **Hierarchy View** tab, as shown in the image below. The attributes you created are displayed; each attribute is a yellow block shape.

![Hierarchy View in MicroStrategy Architect](image)

2. In the Architect toolbar, from the **Home** tab, in the **Hierarchy** area, select **System Hierarchy View** from the drop-down list. You can now begin creating relationships between attributes.

   **To define attribute relationships**

   Creating attribute relationships is an essential step in defining the data stored in your data source.

3. To create attribute relationships, on the **Design** tab, in the **Auto Recognize** area, click the **Recognize Relationships** toolbar icon, as shown in the image below.

   ![Recognize Relationships in MicroStrategy Architect](image)

   The System Hierarchy dialog box opens.
4 You can select from the following options to automatically define attribute relationships. It is recommended that you select all the available options (for background information on the concepts below, see the Project Design Guide):

- **Based on Primary Keys/Foreign Keys**: Creates attribute relationships based on the primary keys and foreign keys defined on your tables. Each attribute that acts as a foreign key of a table is defined as a parent attribute of each attribute that acts as a primary key of the same table. The attribute relationship is defined as a one-to-many relationship from the foreign key attribute (parent attribute) to the primary key attribute (child attribute).
  - This option is ignored if the data source that contains the tables does not support primary keys and foreign keys.

- **Based on lookup tables**: Creates attribute relationships based on lookup tables that do not include primary key or foreign key information. Each attribute that defines a table as its lookup table is defined as a child attribute of all other attributes in the same table, that do not define the table as its lookup table. Each attribute relationship is defined as a one-to-many relationship from the parent attribute to the child attribute.

- **Based on sample data from the table**: Creates attribute relationships for attributes that share the same lookup table.

  Architect analyzes sample data for the tables. The attributes with fewer distinct values are defined as parents of the attributes with more distinct values, using a one-to-many relationship from the parent attribute to the child attribute. For example, a lookup table includes four rows of data, which include data related to year and quarter. Each row includes the same year (for example, 2009), but the quarter changes for each row (Q1, Q2, Q3, Q4). In this case, the Year attribute is created as a parent of the Quarter attribute.

5 Once you have selected the appropriate options, click **OK** to allow Architect to automatically define attribute relationships. The System Hierarchy dialog box closes.

6 After all attribute relationships are determined by the rules that you selected, Architect performs a final analysis on the attribute relationships that are to be created. Any attribute relationships that are found to be redundant are not created. This ensures that attribute relationships are created that properly reflect the design of the data in your data source.
To modify attribute relationships

To modify the type of relationship used to relate two attributes, right-click the relationship line between the two attributes and select one of the following types of relationships:

- **One-to-many**: Each element in the parent attribute corresponds to one or more elements in the child attribute, and each child attribute corresponds to one and only one element in the parent attribute. This is the most common type of attribute relationship. For example, a Year attribute has a one-to-many relationship to a Quarter attribute. One year has many quarters, but a specific quarter can be in one year only. This assumes that quarters are defined with an accompanying year such as Q4 2008, Q1 2009, and so on.

- **One-to-one**: Each element in the parent attribute corresponds to one and only one element in the child attribute, and each child attribute corresponds to one and only one element in the parent attribute. A common example of a one-to-one relationship is citizen and taxpayer ID. A citizen can have only one taxpayer ID and a taxpayer ID can be assigned to only one citizen.

- **Many-to-many**: Each element in the parent attribute can have multiple children and each child element in the child attribute can have multiple parents. In banking, customers and accounts are an example of a many-to-many relationship. One customer may have many accounts, and each account may be associated with many customers, such as in the case of a joint checking account.

For examples and additional details for creating attribute relationships, see the *The Context of Your Business Data: Attributes* chapter in the *Project Design Guide*.

To create hierarchies

Group attributes together into a hierarchy by dragging a selection box around a set of attributes.

Once selected, from the Home tab, in the Hierarchy area, select **New Hierarchy**. The Hierarchy Name dialog box opens.

Type a name to identify the hierarchy. (Report designers will use this name to know what reporting objects are in that group of objects, so make sure the name makes sense for your users.) Click **OK**. The Hierarchy Name dialog box closes.
11 Inside each hierarchy, you can click one attribute and drag a line to another attribute, to define that one attribute is related to the other attribute, and that one attribute can browse to another attribute. A line appears which reflects a browse path between those attributes. Analysts of report data will use these browse paths to drill up or down on a report, from a high summary level of data to a low detailed level of data, and vice versa. For example, an analyst might want to drill from a summarized report on annual revenue, down to detailed monthly or daily revenue data. As another example, a Time hierarchy with defined browse and drilling paths is shown below.

For examples and additional details for creating hierarchies, see the Creating Hierarchies to Organize and Browse Attributes chapter in the Project Design Guide.

To save your progress and exit MicroStrategy Architect

12 When you are finished creating attributes, facts, and hierarchies, click Save to save all your changes.

13 From the Architect icon , select Close to close Architect. The Schema Update dialog box opens.

14 Make sure that the check boxes are all selected and click Update. Then select OK to close the Project Creation Assistant.
To view your new project

15 In MicroStrategy Desktop, expand your project in the Folder List on the left, then expand the **Schema Objects** folder, and then select the **Attributes** folder as shown below. Your new attributes are displayed on the right. Report designers can now use these objects by adding them to reports, based on what the report is intended to display.

Next, you create another important object for report designers to use on reports, called a metric.

**Creating metrics**

For a definition and examples of metrics, see *About projects, attributes, facts, metrics, and hierarchies, page 55.*

To create a metric, you use the facts you created in Architect and place them into mathematical expressions to become metrics. A fact alone simply lists numbers, such as revenue, number of items sold, or cost. A metric incorporates the information provided by the attributes on a report and aggregates the fact data to provide meaningful business measurements such as key performance indicators (KPIs).
For example, if you place a metric that represents your revenue on a report (the Revenue metric), along with the Year attribute and the Month attribute, you can view your organization’s revenue data displayed for each month and year that you store in your data source.

MicroStrategy can define any business measure, from simple SUM metrics, to advanced statistical calculations, to data mining predictions.

Note the following:

- MicroStrategy Architect can automatically create metrics when facts are added to your project. Steps on how to configure this automatic creation of metrics are provided in *To create a project to contain your MicroStrategy reports and reporting objects, page 64.* Metrics created in this way are stored by default in the Public Objects/Metrics folder of a MicroStrategy project.

- By default, facts are created in the Schema Objects/Facts folder of a MicroStrategy project.

Use the steps below to create metrics, based on the facts you created above. For simple examples of metric creation, see the *Building Query Objects and Queries, for Designers* chapter in the *MicroStrategy Basic Reporting Guide.* To create more complex metrics, for example a metric that aggregates data based on a specific attribute in the report, see the *Advanced Metrics* chapter in the *MicroStrategy Advanced Reporting Guide.*

**To create and add a metric to your project**

1. If you need to log in again, in MicroStrategy Desktop log in to the project source you created in *To configure the MicroStrategy Suite, page 20.*

2. In the Folder List on the left side, expand the new project you created, expand the Public Objects folder, and click the Metrics folder. The contents of the Metrics folder are displayed on the right.

3. In the area on the right, right-click, point to New, and select Metric. The New Metric dialog box opens.
4 Click **OK**. The Metric Editor opens, as shown in the image below.

![Metric Editor Image](image)

5 In the Object Browser on the left, select a fact that you want to be part of the metric’s calculation. Drag and drop the fact into the Definition pane at the bottom right. A basic metric expression is automatically created, using the fact you chose and the function SUM.

You can change the function and any other aspect of the metric’s expression. Click $f(x)$ above the expression to access the Functions Library, where you can choose from over 250 functions available in MicroStrategy. Your metric expression can be as simple or as complex as you choose to make it, depending on your business users’ requirements for data calculation.

By default, metrics are calculated at the level of the attributes on the report. For example, a report contains a Revenue metric and the attribute Year. The metric is automatically calculated to display revenue for each year in your data source. When the same Revenue metric is placed on a report containing the Customer attribute, the revenue is calculated for each customer.

Additional settings that govern how metrics are calculated are covered in detail with examples in the *Advanced Metrics* chapter in the *Advanced Reporting Guide*.

6 To save the metric, click **Save and close**. Type a name for the metric and click **Save**. The metric is now saved in the Metrics folder, and is available for use by other MicroStrategy Suite users.
Repeat the steps above to create any additional metrics that you want in your project.
Introduction

Reports display your business data, and are the focus and goal of business intelligence. You perform data analysis on reports to gather business insight. The results displayed in any MicroStrategy report are often a starting point for further investigation.

Use the steps in this chapter to create standard MicroStrategy reports. There are also steps to display report results in an interactive, graphical widget on an iPhone, iPad, or Android device.

Creating a report

You create reports by placing MicroStrategy objects on the report. These objects include such things as attributes, metrics, filters, prompts, custom groups, and consolidations. The attributes and metrics you have created thus far are sufficient to create basic reports.

- **Attributes** provide descriptive information about your business. Examples of attributes include such concepts as Year, Month, Day,
Region, State, City, Product Category, Subcategory, Item, and so on. Attributes provide context for the calculated data displayed on the report. By default, attributes are stored in the Schema Objects/Attributes folder of a MicroStrategy project.

- **Metrics** are the business calculations you want to analyze. Examples of metrics include Revenue, Profit, Cost, Percentage of Sales, Number of Items Sold, and so on. Metrics are commonly stored in the Public Objects/Metrics folder of a MicroStrategy project.

For detailed information and examples about other MicroStrategy reporting objects, see the *MicroStrategy Basic Reporting Guide*.

The steps below show you how to build a simple grid report. Reports are useful on their own, and can also be used as a prerequisite to building streamlined and highly interactive Mobile reports, dashboards, and applications.

**Prerequisite**

- MicroStrategy Web must be configured. For steps to configure MicroStrategy Web, see *Configuring MicroStrategy Web, page 30*.

**To create a report**

1. Open MicroStrategy Web. To do this, from the Start menu, point to Programs, then MicroStrategy, then Web, then Web.

2. Log in to the project source that you created in *Chapter 2, Creating a MicroStrategy Project with Your Data*.

   Use your MicroStrategy login and password. If you did not create one, use the default MicroStrategy administrator account, by typing Administrator as the User Name. The default account does not use a password, so leave the Password field blank.
3  Click the **Create Report** icon to access the Create Report page.

4  Click **Blank Report** and ensure that the **View report in Design Mode** option, at the top, is selected. The Report Design Mode page is displayed as shown in the image below.

The Report Editor has several main areas:

- Displayed at the left, and accessible from the bottom left:
  - **Report Objects**: On the left, the Report Objects pane lists all objects currently on the report. Display this pane using the tabs at the bottom left.
All Objects: On the left, All Objects is where you navigate to and select objects to use on the report. Display this pane using the tabs at the bottom left.

Notes: On the left, the Notes pane enables collaboration between users who review the data on this report. Display this pane using the tabs at the bottom left.

Related Reports: On the left, the Related Reports pane displays reports that are available in the same folder location as this report. Display this pane using the tabs at the bottom left.

- Report Filter and View Filter: Above the report template, you can use these panes to define filtering conditions that restrict or refine the data displayed on the report.

- Page By: Above the report template, use this pane to place subsets of your report results to be displayed as separate pages of the executed report. It is useful to group report data into subsets if the report will return a large amount of data.

- Template: The large grid on the right is the report’s template. The template area displays the layout of the report, and is where you place objects from the Report Objects and All Objects panes.

For more information on these concepts, including filters, page-by, and templates, see the Basic Reporting Guide.

5 Start by adding an attribute or metric to the report content and layout in the report’s Template pane. To add an attribute or metric, select All Objects at the bottom left and navigate to each of the objects to include on the report. Right-click an object, and select Add to Grid.

A common practice is to place attributes on the rows and metrics on the columns.

If you plan to use this report on an iPhone, iPad, or Android later, make sure that you place objects on the report according to the following requirements:

- To create a report that can be used as an Interactive Grid widget (for an example, see Displaying a report as an Interactive Grid widget on a mobile device, page 93):
  - Place at least one attribute on the grid’s rows. The elements of this attribute will be displayed in the first column of the widget.
  - Place at least one metric on the grid’s columns. The metric values will be displayed in additional columns in the widget.
• To create a report that can be used as a Time Series widget (for an example, see Displaying a report as a Time Series widget on a mobile device, page 95):

  □ Place at least one attribute on the report’s rows. The attribute provides the values along the horizontal axis of the widget and should be time-based. The last (right-most) attribute on the rows determines the granularity, or level, at which users can view data in the widget. For example, if the granularity is set to the Day level, users can view data in the widget for each individual day.

  □ Place at least one metric on the report’s columns. The values of this metric are graphed in the widget.

  □ To view data for multiple series, place at least one attribute on the report’s columns. The elements of this attribute are each graphed on the widget’s axis.

6 To save your report, click **Save As**. Type a name for the report and click **OK**.

   ![Tip] By default, the folder where the report is saved is the My Reports folder, where objects are only visible to you. You can save the report in the Shared Reports folder so it is visible to all users.

7 You can click **Run Report** to see the display of your new report.

For detailed tips on design techniques specific for reports and dashboards that will be used on Mobile devices, see:

• Defining a report for display on a mobile device, page 91.

• The Designing Reports and Documents for Mobile Devices chapter in the MicroStrategy Mobile Design and Administration Guide.

• The Designing Reports and Documents for Mobile Devices chapter on the MicroStrategy Mobile Design and Administration Guide.

**Creating a graph**

Graphs help users to gain quick insights into their business data efficiently and effectively, and help identify trends, patterns, and spot outliers. MicroStrategy gives users a quick way to create and format a broad range of graphs and charts. Almost any report can be turned into a graph.
While performing the steps below, if you encounter a scenario with your data or environment that requires some special handling, see the Graphing chapter in the MicroStrategy Advanced Reporting Guide.

To create a graph

1. In MicroStrategy Web, click a report to run it.

   Viewing a report in graph view

2. From the Home toolbar, click on the Graph button to change the view mode.

3. Click the Graph menu to display the Graph toolbar options. Select the graph style that best fits your data.

   For your first few graphs, use one of the following graph styles, as these fit most sets of data. These styles require at least one attribute and one metric on your report:

   • Area
   • Bar
   • Line
   • Pie

   For a table showing the exact requirements that a report must meet to be displayed successfully in a given graph style, see the Graphing chapter in the Advanced Reporting Guide.

4. Click OK. The Graph Type dialog box closes and the report is displayed as a graph.
**Adding additional attributes or metrics to the graph**

5 To display the graph drop zones, from the **Tools** menu, click **Graph Zones**. In this view, you can make changes to the graph and see the immediate effect of those changes.

![](image)

6 From the **Tools** menu, click **Report Objects** to see the attributes and metrics available for this report.

7 To add an attribute or a metric to the graph, browse to the attribute or metric in the **Report Objects** or **All Objects** panes, then click and drag the attribute or metric into the appropriate drop zone. It is shown immediately on the graph.

- **Metrics are all displayed on the same axis.**
Customizing the appearance of the graph

8 To customize the appearance of your graph, right-click anywhere in the graph and select **Format**. The Format Graph dialog box opens.

9 On the left, expand the aspect of the graph report that you want to change, and change the settings. For example:

- To display a title on the graph, Click **Format**, select **Titles** from the first drop-down list, and then select **Title** from the second drop-down list. Select the **Show** check box, and type the text to display as the graph’s title.

- To format the background of the graph, select **Format** from the first drop-down list, and then select **Background** from the second drop-down list. Specify the line color for the border and the overall background color, effect, and transparency of the background.

- To change the font of the axis labels, select **Axes** from the first drop-down list, and then select **All Axes** from the second drop-down list. Specify the font name, font size, font color, font style, and text effects.
10 To apply your changes to the graph, click **Apply**, and then click **OK**.

11 When you are ready to save your graph, from the toolbar, click **Save**.

This single report definition is used to display both the grid view of the data and the graph view of the data. You can switch between the grid view and the graph view by running the report and selecting **Grid** or **Graph** from the toolbar menu.

### Defining a report for display on a mobile device

Using MicroStrategy Web, you can define a MicroStrategy report to display as a widget, and then display the widget on a mobile device. This lets you display the report data in an interactive format on a mobile device.

A widget is a rich, graphical display of the report results, allowing users to visualize data in different ways than traditional reports do. Widgets are sophisticated visualization techniques that can combine with rich interactivity to enable users to understand their data more effectively.

You can define a report to display as a widget when the report is executed on a mobile device that has the MicroStrategy Mobile client application. A report can be displayed on a mobile device as one of several types of widgets. Two of the most common include:

- Interactive Grid widget: Displays data in a compact tabular layout.
- Time Series widget: Displays data in a line graph over a specific period of time.

The steps that follow show you how to define a report as both of these types of widgets.

Another popular type of widget that you can display on a mobile device is a Map widget. Map widgets allow users to search and view information based on locations on a map. For details on the Map widget, see the *Designing Reports and Documents for Mobile Devices* chapter in the *MicroStrategy Mobile Design and Administration Guide*.

For details on exploring data using the widgets, see *Visualizing data in an out-of-the-box widget, page 138*.
Prerequisites

- MicroStrategy Web is configured. For details on how to set up MicroStrategy Web, see *Configuring the Mobile client, page 39*.

- The Custom Visualization Editor is enabled. Enable this editor using the following steps:
  
  a From the **Start** menu, point to **Programs**, then **MicroStrategy**, then **Web**, then select **Web**. Log into the MicroStrategy project in Web using the following default login credentials:
    
    Login: Administrator

    Password: (leave this field blank)

  b Click the **Preferences** link in the toolbar. Then, on the left under Preferences Level, select **Project Defaults**.

  c On the left under Preferences, select **General**. On the right, scroll to the bottom of the page and select the **Enable Custom Visualizations Editor** check box.

  d Click **Apply**. The Custom Visualizations Editor is now available for report and dashboard designers to work with widgets.

For details on enabling, disabling, and using all the options in the Custom Visualization Editor, click ? in the editor to see the MicroStrategy Web Help.
Displaying a report as an Interactive Grid widget on a mobile device

The Interactive Grid widget allows you to display data in a compact tabular layout on an iPhone that has MicroStrategy Mobile installed. Attributes and metric values are displayed in columns in the widget’s grid, as shown below.

If a column contains more than one metric, users can toggle the metric that is displayed in the column to customize their display.

You can either display an existing report as an Interactive Grid widget on a mobile device, or you can add an Interactive Grid widget to a dashboard that can then be displayed on a mobile device. The widget is displayed when the report or dashboard is viewed on a mobile device using the MicroStrategy Mobile client application.

Prerequisites

- This procedure assumes that you have already created a grid or graph report with the following required objects on it. (For steps to build a sample grid report, see Creating a report, page 83.)
  - Place at least one attribute on the grid's rows. The elements of this attribute are displayed in the first column of the widget.
To define a report as an Interactive Grid widget

1. From the **Start** menu, point to **Programs**, then **MicroStrategy**, then **Web**, and then select **Web**.

2. Log into the MicroStrategy project using your MicroStrategy login and password.

3. Browse the folders to locate the report that you created above.

   The Shared Reports folder (available from the top toolbar) displays all reports that are saved in the Reports folder in MicroStrategy Desktop.

4. Click the name of the report to run it.

5. From the **Tools** menu, select **Custom Visualizations**. The Custom Visualizations Editor opens. (If the editor is not available, see Prerequisites, page 92 for steps to enable it.)

6. From the **iPhone** drop-down list, select **Interactive Grid**.

7. Click the **Visualization Properties** icon next to the iPhone drop-down list. The Interactive Grid Properties dialog box opens.

   - If you see an error message about merged rows, from the **Tools** menu select **Report Options**, and then clear the **Merge Rows** check box.

8. To apply banding to the widget (which shades every other row of the report data, making it easier to read), select the **Banding** check box.

9. By default, the width of the columns in the widget is automatically determined. This is set using the **Automatic column sizing** check box.

   - If you want to manually specify the width of each column, clear the **Automatic column sizing** check box. Then, in the **Width (%)** fields, specify the width of each column as a percentage. The widths for all columns must add up to 100.

   For details on all the options in the Interactive Grid Properties dialog box, click ? to open the Help.

10. You can specify whether or not the name of a column is displayed in the widget as a column heading. Do one of the following:

    - To display the column heading, select the **Toggle** check box.
To hide the column heading, clear the **Toggle** check box.

11 You can add, rearrange, or delete columns in the widget:

- To rearrange report objects within the columns, click a report object and drag it to a new location.
- To add a new column to the grid, click **Add Column**. The new column is added.
- To delete a column, click X at the far right of the column.

The first two columns in the grid report are added to the widget by default and cannot be deleted.

12 Click **OK** to return to the Custom Visualizations Editor.

13 Click **OK** to save your changes and close the Custom Visualizations Editor.

14 Save your report.

To display and analyze the reports on the iPhone, see *Analyzing reports and dashboards from an iPhone, page 127*.

### Displaying a report as a Time Series widget on a mobile device

The Time Series widget in MicroStrategy Mobile allows you to display data over a specific period of time. This widget is displayed as a line graph on the MicroStrategy Mobile client application on a mobile device. You can display this widget on an iOS device or an Android device; the steps below use the iPhone as an example.
You can configure the widget to display multiple data series on the same graph. For example, the values of the Deficit Rate of Change metric for the US and world over a six-month period are displayed in the image below:

![Image of a mobile device displaying multiple data series](image)

You can configure the Time Series widget to provide data across multiple time intervals. For example, in the image above, data is displayed for a six-month time period. The widget can also display data for one day, one week, one month, one quarter, one year, or several years. You can add time intervals to a widget by configuring the widget’s properties.

You can create a widget for display on a mobile device in two ways, by either defining a report to display as a widget, or by adding a widget to a dashboard and displaying the dashboard on the mobile device.

The following steps show you how to use MicroStrategy Web to set up a report so that it displays as a Time Series widget when the report is run on an iPhone.

**Prerequisites**

- This procedure assumes that you have already created a grid or graph report with the following requirements. (For steps to build a sample grid report, see *Creating a report, page 83.*)
  - Place at least one attribute on the report’s rows. The first (left-most) attribute provides the values along the horizontal axis of the widget and should be time-based. The last (right-most) attribute on the rows determines the granularity, or level, at which users can view data in the widget. For example, if the granularity is set to the Day level, users can view data in the widget for each individual day.
  - Place at least one metric on the report’s columns. The values of this metric are graphed in the widget.
To view data for multiple series, place at least one attribute on the report’s columns. The elements of this attribute are each graphed on the widget’s axis.

### To set up a report to display as a Time Series widget

1. From the **Start** menu, point to **Programs**, then **MicroStrategy**, then **Web**, and then select **Web**.

2. Log into the MicroStrategy project that contains the report that you created above. Log in using your MicroStrategy login and password.

3. Browse through the folders to locate your report.

   - The Shared Reports folder (available from the top toolbar) displays all reports that are saved in the Reports folder in MicroStrategy Desktop.

4. Click the name of the report to run it.

5. From the **Tools** menu, select **Custom Visualizations**. The Custom Visualizations Editor opens. (If Custom Visualizations is not available, see **Prerequisites, page 92** for steps to enable it.)

6. From the **iPhone** drop-down list, select **Time Series**.

7. Click the **Visualization Properties** icon next to the iPhone drop-down list. The Time Series Properties dialog box opens.

   - If you see an error message about merged rows, from the **Tools** menu, select **Report Options**, and then clear the **Merge Rows** check box.

### To add a time interval selector to the widget

Interval selectors let users select the time period for which they want to view data in the widget, allowing them to examine the data at different levels of detail. You can add, move, or delete interval selectors in a Time Series widget.

8. Click **Add Interval**. Type a name for the selector in the **Name** field.

9. Granularity is determined automatically based on the last (right-most) attribute on the report’s rows, as described above.
10 From the **Interval Unit** drop-down list, select the unit in which to specify the length of the time interval. In the image above, a six-month interval is defined, so Month is selected as the interval unit.

11 In the **Interval Size** field, type the number of units to include in the interval. For example, if the interval unit is defined as Month, you can type 6 to specify a six-month time interval, as shown in the image above. A summary of the interval selector’s properties is displayed in the bottom pane.

12 You can repeat these interval selector steps to define additional interval selectors for users to choose from. If you create additional interval selectors, you can rearrange the order in which the interval selectors are displayed to users, by clicking **Move up** and **Move down** to change the position of a selector. To delete an interval selector, select its name in the pane on the left and click **Remove**.

13 Click **OK** to save your interval selector. The Time Series Properties dialog box closes.

14 Click **OK** to save your changes and close the Custom Visualizations Editor.

15 Save the report.

To display and analyze the reports on the iPhone, see *Analyzing reports and dashboards from an iPhone, page 127.*

**Creating a micro application for a mobile device**

MicroStrategy Mobile allows designers to create micro applications, or apps, that can be used on an iPhone, iPad, or Android device. An app designed in MicroStrategy consists of an organized set of reports and dashboards combined to provide a guided workflow for the end user. (A dashboard is a type of document in MicroStrategy.)
A micro application can be created using a dashboard as the home page, with navigation and workflows based on buttons and links added to the home page. The example below shows a sample app created in MicroStrategy:

Apps can be quickly designed, without using code, and you can customize the look, feel, and behavior of each app using mobile device-optimized displays and controls. Users of these apps can explore information by tapping, swiping, rotating, and shaking, as well as connecting to the camera, voice GPS, email, and other features on an iPhone, iPad, or Android device.

The steps below explain how to create a simple iPhone or iPad app consisting of a Welcome screen and links to a grid report and a graph report. These grid and graph reports are displayed as widgets, which are designed specifically for iPhone or iPad display.

**Prerequisites**

- MicroStrategy Web is configured. For details on how to set up MicroStrategy Web, see *Configuring the Mobile client, page 39.*
• Reports are created that will be used as parts of the app workflow. For details on creating reports, and steps to define a report to be displayed as a widget, see *Creating a report, page 83* and *Defining a report for display on a mobile device, page 91*.

---

**To create a Welcome screen for an iPhone or iPad app**

1. From the **Start** menu, point to **Programs**, then **MicroStrategy**, then **Web**, and then select **Web**.

2. Log into the MicroStrategy project using the default administrator account, by typing **Administrator** as the **User Name** and leaving the **Password** field blank.

3. Click **Create Document** at the top of the page.

4. From the list of templates, select one of the following, depending on whether you want to create an app for display on an iPhone or an iPad:
   - **iPhone Portrait Micro Application**
   - **iPad Landscape**

   These templates are optimized for the smaller format of iPhone and iPad apps. The templates allows you to better control the user’s experience and interaction with the app. For complete details on all the templates available for the iPhone and iPad, see the MicroStrategy Web Help.

**To insert a text field to be used as a link to a report**

A link is a connection in an app to another app, dashboard, or report. Tapping a link lets a user execute another app, dashboard, or report (the target) from an app or dashboard (the source), and to pass parameters to answer any prompts that are in the target. You can link from a text field or an image. These steps create a text field.

5. From the **Insert** menu, select **Text**. When you move the cursor to the layout area, the pointer changes to crosshairs.

6. Click in the layout area where you want to place the text field. If you click and drag in the area, you can resize the text field.
7 Type the text to be displayed to users.

The text field is automatically formatted in a default style, but you can change the formatting. For details about formatting text fields, click ? to open the Help or see the MicroStrategy Report Services Document Creation Guide.

To retrieve link information for the target report or dashboard

To convert the text field into a link, you must locate and provide the object ID of the target report or dashboard as well as the rest of the correct link syntax (the link’s URL).

8 In MicroStrategy Web, navigate to the target report or dashboard, right-click the name, and select Properties. The Properties dialog box opens.

9 Right-click the URL next to Link, and select Copy Shortcut. This URL is the information that will enable a link to trigger the execution of this report or dashboard.

10 Click Cancel.

To create a link in an iPhone or iPad app

11 In the app template that you were working in above, right-click the text field that you added and select Properties and Formatting. The Properties and Formatting dialog box opens.

12 Select General on the left, then select the Is hyperlink check box.
13 In the **Hyperlink** field, delete the “http://” text that is displayed by default, and paste the URL to be triggered when the user taps the text field/link. Press Ctrl+V to paste the copied URL.

14 Click **OK**. The text field is now underlined, indicating that it is a link.

15 Save your dashboard.

Links can also trigger applications that are stored on your mobile device, such as email, phone, text messages (SMS), maps, and YouTube videos. For more information on linking to reports, documents, and apps, see the *Designing Reports and Documents for Mobile Devices* chapter in the *MicroStrategy Mobile Design and Administration Guide*.

For complete details on creating dashboards as apps, adding prompt parameters to links, and configuring how an app interacts with other apps installed on a mobile device, see the *Designing Reports and Documents for Mobile Devices* chapter in the *MicroStrategy Mobile Design and Administration Guide*.

---

**Formatting a dashboard for display on a mobile device**

It is important to design reports and dashboards to ensure that they can be easily viewed and the data analyzed on a mobile device. Dashboards can be formatted to display on iOS and Android devices; this procedure uses the iPad as an example.

When you design reports and dashboards to analyze on a mobile device, design them so that users can view all the data in a single screen without scrolling or swiping back and forth. If more data must be displayed than will fit on one screen, consider using panel stacks to combine the data in a way that lets the user navigate the data by swiping or tapping selectors. (A set of data is displayed on a panel; you can make a lot of data available by stacking several panels of data.)

There are two important features you can use on a dashboard, which enable easy data navigation and reader understanding. These are described below. Steps follow to enable these features in a dashboard.

- You can display a row of circles at the bottom of a screen which the user can tap to see the next group of data. This row of circles is a docked panel
selector, which lets you display widgets grouped on panel stacks on a mobile device. For steps to create a docked panel selector, see *Providing subsets of data on an iPad dashboard, page 103.*

- You can display a pop-up window that shows users additional details about an attribute element that they select. This is called an Information Window. For steps to create an Information Window, see *Providing additional information for an iPad dashboard, page 105.*

For complete details about designing Report Services documents and dashboards, see the *Report Services Document Creation Guide.*

**Providing subsets of data on an iPad dashboard**

A docked panel selector allows users to switch between panels (or groups) of data by tapping a selector bar (a row of circles) that appears at the bottom of the panel stack. An example of a panel stack with a docked selector beneath it is shown below.

A row of circles is displayed at the bottom of the panel stack. Each circle represents a panel, with each panel containing a subset of data. The currently displayed panel is marked with a dark circle.
The steps below show you how to create a docked panel selector for a dashboard, and provides high-level steps to create the rest of the dashboard.

**To create a docked panel selector**

1. From the Start menu, point to Programs, then MicroStrategy, then Web, and then select Web.

2. Log into the MicroStrategy project using the default administrator account, by typing Administrator as the User Name and leaving the Password field blank.

3. You can either create a new dashboard or open an existing dashboard.

4. In Design mode, from the Insert menu, choose Panel Stack. When you move the cursor over the layout area, the pointer changes to crosshairs.

5. Click and drag in the layout area to create and size the panel stack.

**To create and configure a selector for the panel stack**

6. Right-click the panel stack and choose Create Panel Selector. A drop-down selector appears above the panel stack.

7. Right-click the panel selector and choose Properties and Formatting. The Properties and Formatting dialog box opens.

8. On the left, choose Selector. In the Mobile - iPad area, select the Display selector docked to its panel stack check box.

9. Click OK to save your changes.

**To add panels and content to the panel stack**

10. Hover the cursor over the panel stack. A toolbar appears.

11. Click Add Panel to add a panel to the stack.

12. For each panel, click Add Content and add data in the form of grid reports or graph reports to the panel.

13. Click Add Panel to add each additional panel to the panel stack, then click Add Content to add data to each panel.

14. Save the dashboard.
Providing additional information for an iPad dashboard

Information Windows let users view additional information about an attribute element by tapping the element in a grid report or graph report. The Information Window pops up over the element, displaying more detailed data about the element. An example of an Information Window in an iPad is shown displayed on top of the report below.

In the example above, the Subcategory column in the grid report is designated as a selector by the dashboard’s designer. When a user taps the Audio Equipment element in the Subcategory column, the Information Window opens.

To use an Information Window in a dashboard that is designed to be used on an iPad, you must define a panel stack to be used as the Information Window, and you must define a Grid/Graph selector that targets the panel stack. Steps to do this are below.

**Prerequisite**

- The dashboard must contain at least one Grid/Graph containing a dataset.
To create an Information Window in an iPad dashboard

1. From the Start menu, point to Programs (or All Programs), then MicroStrategy, then Web, and then select Web.

2. Log into the MicroStrategy project using the default administrator account, by typing Administrator as the User Name and leaving the Password field blank.

3. Navigate to the dashboard you want to add an Information Window to. The dashboard must contain at least one Grid/Graph containing a dataset.

   For example, the dashboard shown below contains data from a basic grid report in the Grid/Graph:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Region&gt;</td>
<td>&lt;Employee&gt;</td>
<td>&lt;Revenue&gt;</td>
<td>&lt;Cost&gt;</td>
<td>&lt;Profit&gt;</td>
<td></td>
</tr>
</tbody>
</table>

4. Open the dashboard in Design mode.

   To define the panel stack for the Information Window

5. From the Insert menu, choose Panel Stack. When you move the cursor into the layout area on the right, the pointer becomes crosshairs.

6. Click and drag anywhere in the Layout area to create and size the panel stack. The panel stack is added to the dashboard.

7. Right-click the panel stack and select Properties and Formatting.
8 From the left, click **General**, then type a name for the panel stack in the **Name** field. This name appears as the title of the Information Window when it is displayed on the iPad.

9 Select the **Use as Information Window** check box.

10 Click **OK** to save your changes.

11 Add a Grid/Graph to the panel stack.

For example, in the dashboard above, a pie chart showing revenue for each year is added to the panel stack, shown below:

![Pie Chart Example]

12 In the stand-alone Grid/Graph, right-click the attribute to use as the selector, and choose **Use as Selector**. MicroStrategy Web automatically attempts to find targets for the selector.

In the example above, the Region attribute is configured as a selector.
13 To verify that the selector targets the Information Window, right-click the attribute again and choose **Edit Selector**. The Configure Selector dialog box opens, as shown below.

![Configure Selector Dialog Box](image)

14 Ensure that the Information Window panel appears in the Selected Targets list.

15 Click **OK**.

16 Save the dashboard.
For the example above, when the document is executed on an iPad, the Information Window appears when the user selects an element in the Region column, as shown below.

### Designing reports for viewing on a BlackBerry

Reports and documents displayed on a BlackBerry can be created in either MicroStrategy Desktop or MicroStrategy Web by a report or document designer. Complete details to design a report are available in the *Basic Reporting Guide* and *Advanced Reporting Guide*. Details to design a document or dashboard are in the *Report Services Document Creation Guide*.

This section covers design information that is specific for reports and documents that are intended to be used on a BlackBerry.

It is important to design reports and documents effectively to ensure that the data in them can be analyzed easily and efficiently on a mobile device.
Best practices for designing mobile-friendly reports

When designing a report for use on a BlackBerry, consider the following best practices for report and document display on a mobile device:

• Limit the total number of attributes and metrics displayed on the report’s rows and columns to six. This allows BlackBerry users to view as much data as possible at one time.

• Keep the report as focused as possible by providing only the report objects essential for effective report analysis.

• Any report designed with objects in its page-by field will display the currently selected page-by data in the BlackBerry, by default. The page-by field can be changed by the end user on the BlackBerry.

If the report is designed in original layout data view, changing objects in the page-by field is disabled. For details on the different data views, see the Designing Reports and Documents for Mobile Devices chapter in the MicroStrategy Mobile Design and Administration Guide.

• A report’s font colors and styles (bold, italic, underline) are displayed on the BlackBerry. However, font types and sizes, and the alignment of text, are not applied to the report. Consider this when formatting the text on your report. Users can adjust the font size on the BlackBerry.

• Thresholds involving the size and alignment of text are not supported. Additionally, custom image-based thresholds are not displayed on the BlackBerry.

• Report size guidelines:
  - If a report or document is 125 KB or larger, it will not be downloaded to a mobile device. If this issue occurs, redesign the report or document in MicroStrategy Desktop or Web to use it in MicroStrategy Mobile.
  - A report or document in MicroStrategy Mobile is typically about 1/5 to 1/2 the size of the same report or document in MicroStrategy Desktop or Web, depending on the size and complexity of the report or document.
  - Some smaller reports and documents can be compressed to about 1/10 of the size of the same report or document in Desktop or Web.
• Designing graph reports:
  ▪ When designing a graph report in MicroStrategy Desktop, enable Automatic graph layout. This ensures that the objects on the graph are not repositioned on the BlackBerry. For steps, see the Graphing chapter of the Advanced Reporting Guide.
  ▪ Consider using graphs with only enough series to best fit on the screen at one time.

For details to design a report in MicroStrategy Desktop or Web, see the Basic Reporting Guide.

For more information on how to design reports and dashboards optimized for BlackBerry clients, see the Designing Reports and Documents for Mobile Devices chapter in the Mobile Design and Administration Guide.
EXPLORING DATA WITH MICROSTRATEGY SUITE

Introduction

You can view reports, documents, and dashboards on a computer (with MicroStrategy Web) or on a mobile device (with MicroStrategy Mobile). You can also view reports, documents, and dashboards within a Microsoft Office product such as Word, Excel, or PowerPoint (using MicroStrategy Office).

- Running reports and exploring data in MicroStrategy Web, page 114
- Visualizing the data, page 120
- Drilling through the data, page 123
- Running ad hoc reports, page 125

For full details, images, and examples on any of the features described below, see the MicroStrategy Basic Reporting Guide.
Running reports and exploring data in MicroStrategy Web

Each project that you log into in MicroStrategy Web opens the project’s Home page, which provides options for interacting with the project in a navigation sidebar on the left. Options include:

- **Search** provides a search box in the main panel, with search options in the left panel.
- **Browse** displays folders, reports, and documents in the project so that you can browse its contents.
- **Create** is a link to stored reports that have been run on a schedule and delivered to the History List folder.
- **Tools** is a link to a list of scheduled reports, where you can manage subscriptions to scheduled reports.

You can minimize the navigation sidebar using the arrow. Clicking the logo at the upper left opens a drop-down menu with options that allow you to:

- Access folders
- Set preferences
- Access user and shared reports
- Manage History Lists and subscriptions
- Create reports, documents, and analyses
- Log out

To get help with a feature or dialog box, click the 🍀 icon at the upper right of the page.

You can view and interact with reports using the following steps.

If you encounter scenarios or questions not covered by this guide, see the *MicroStrategy Basic Reporting Guide* or click 🍀 to open the Help for details on all options in the software.
To browse a project and run a report

   - Use the default MicroStrategy administrator account, by typing Administrator as the **User Name**. The default account does not use a password, so leave the **Password** field blank.

2. Click **Browse**, which is located on the left, to show a list of folders associated with the project.

3. Click **Shared Reports**. Reports that are to be shared with a user community can be stored here.
   - This folder in Web displays all reports that are saved in the **Reports** folder in MicroStrategy Desktop. (In Desktop, from the Folder List on the left, expand **Public Objects**, then expand **Reports**.)

You can create folders to group related reports for your MicroStrategy project. Security settings can be defined to determine which folders and reports you can see.

To display the list of folders on the left as shown below, from the toolbar, click **Show Navigation Tree** and **View: Icon**.
To locate a specific report you can either navigate to the location or you can run a search to return the report:

- To navigate to a specific report, click any folder to see the reports contained within it.
- If you know the name of a report that you want to see, click the **Search** field at the top and type a search term that contains one or more words of the report name.

The image below shows a list of some sample reports within a folder in a MicroStrategy project. The different icons represent different types of reports: for example, a grid report (similar to a standard spreadsheet), a graph report, or a combination grid and graph report.

The PDF and Excel dots at the bottom of an icon identify the default output format of a report. Report icons with no dot are displayed in HTML format. Moving the mouse over a reporting object reveals links to accomplish different tasks, such as to Edit an object or to convert it to a PDF file.
To run a report, click the report name.

- A sample grid report is shown in the image below.

![Sample Grid Report](image1)

- A sample graph report is shown in the image below.

![Sample Graph Report](image2)

A prompt is a question presented to users when they run a report, asking them to indicate what data they want to see. If the report you open contains a prompt, you are presented with a page of options to select before the report is displayed. Select the data that you want to be displayed on the report and then click **Run Report**. A sample prompt page is shown in the image below. For details about answering every kind of prompt in MicroStrategy, see the *Answering Questions About Data* chapter in the *Basic Reporting Guide*. For details about creating a prompt in MicroStrategy, see...
the Building Query Objects and Queries, for Designers chapter in the Basic Reporting Guide.

6 After the report is displayed, you can see the data from your data source, calculated according to the rules defined by the metrics used on the report, and aggregated to the level of the attributes in the report.

In addition to looking at the data displayed, there are some other parts of a report that provide important information about what data was filtered to be included in the calculations and what data was filtered to be excluded. The image below shows a sample report, with some important areas indicated.

- **Report Details**: The image above shows you where you can read a description of the report, usually written by the person who created the report. The description appears in the Report Details area. This
area also shows you what data the report filter included in the report, and what data was excluded from the report.

- **Prompt Details**: If your report included prompts, the image above shows where you can read a list of the answers you provided to the prompt questions. Your answers helped to further filter the data brought back from your data warehouse. Not all reports contain prompts.

7 To interact with the data on your report, use the toolbars displayed above the report. The toolbars are highlighted in the sample report shown in the image below. (The Report Details and Prompt Details areas have been hidden from view, to display the report itself in a larger available space. To hide these areas, click \(\text{?}\) and/or \(\text{?}\) on the Tools menu.) To display different toolbars, click the menu tabs above the toolbar.

Common actions include the following, and can be performed by clicking the toolbar icons shown below:

- View the report in Full Screen mode: \(\text{View Full Screen}\) on the Home menu.
- Print the report: \(\text{Print}\) on the Home menu.
- Export the report to Microsoft Excel: \(\text{Export}\) on the Home menu.

Groups of data from a MicroStrategy report can be displayed in separate workbook tabs in Excel. (The groups of data are selected for display using the page-by fields at the top of reports where page-by is enabled.) All Excel functionality can be used on the exported data. For example, you can modify formatting, change values, and add formulas after the data has been exported.
• Export the report to Adobe PDF: on the Home menu.

• Refresh the report to display the latest data: on the Data menu.

• Schedule a report to run automatically: on the Home menu.

Scheduled reports are run at a regular time you determine, and the report results are automatically delivered to a folder named History List in your MicroStrategy project. To see a scheduled report, select History List at the top of any page. Click the History List message to see the report results.

• View subsets of data on a large report:

For larger reports, the report’s designer may have grouped the report results so that you only see a subset of data at one time. You can select different subsets of data to view by clicking a Page-by drop-down list. Not all reports contain page-by fields.

• Annotate a report by adding notes: on the Tools menu.

Type your comments in the box at the bottom left, then click Submit. Notes can be useful to collaborate with colleagues, or to provide guidance on how the report should be used.

• Sort data to quickly see the highest and lowest numbers. To sort, right-click any column heading, select Sort, then select Ascending or Descending. Sorting can answer such questions as, What is my most profitable product line? Who is my least productive salesperson?

• Perform an advanced sort on multiple columns: on the Data menu.

• Display totals or subtotals: on the Data menu.

• Control font, color, and threshold options using the Format menu.

Not all actions listed above may be available for every report. Some actions may not be enabled by the report’s creator.

Visualizing the data

MicroStrategy provides a variety of visualization tools to derive insights from large amounts of data, and to format the information.

© 2012 MicroStrategy, Inc.
To visualize your report data in new ways

1 Run a report in MicroStrategy Web. Use the steps above in Running reports and exploring data in MicroStrategy Web, page 114 to locate and run a report.

2 For a grid report, you can apply different layouts and formats to the data. (If your report is not displayed as a grid, from the View menu click the Grid icon.)

3 To apply a different layout and format, from the Grid menu, click the Autostyles drop-down list (which displays the name of the currently selected autostyle), as shown in the image below. Then select from the many autostyles available.

4 You can resize the data display by selecting Auto Fit to Contents or Auto Fit to Window. Both are on the Grid menu.
5 You can improve the readability of the data by adding bands to the data. The sample grid report below shows the data after banding is applied, with alternate rows displayed in different colors.

6 Display the report as a graph: A graph or chart is a visual representation of the data and is often the best way to derive insight from the data, as shown in the image below.

7 To work with a graph report:
   - Hover the cursor over a part of the graph, such as one of the riser bars as shown in the graph above, or a point on a line graph. The data point you are viewing is displayed in a tooltip.
   - If available on the report you are viewing, use the Page-by feature described above to slice through the data.
• Display the data as both a grid and a graph:

Drilling through the data

Drilling provides a view into the details of the report’s data. When data is organized hierarchically in a storage system, the data can be displayed at a high, summarized level. By clicking report items to drill deeper into data, areas of interest can be investigated all the way down to a low, detailed level.

Drilling allows users to change the initial report definition dynamically without having to design and store the new reports beforehand. Drilling allows users to explore data deep within a report to identify and discover important trends in their business. In MicroStrategy, drilling always takes into consideration the privileges and security profile of each user.

For complete details on drilling, with images and examples, see the MicroStrategy Basic Reporting Guide.
To drill on data in MicroStrategy Web

1 Run a report in MicroStrategy Web. Use the steps above in *Running reports and exploring data in MicroStrategy Web, page 114* to locate and run a report.

2 In a grid report, right-click any column or row heading and select **Drill**.

3 From the drilling options available, choose the direction you want to drill.

   For example, if you drill on a row heading named Product Subcategory, you might drill up to a higher, summary level by selecting Product Category. Or you might drill down to a lower, more detailed level by selecting Product Item.

   If you drill on a time-related row or column heading, such as Month, you might drill up to a higher level by selecting Year or Quarter. Or you might drill down to a lower level by selecting Day or Week. Your organization’s data might go even lower, to Hour or Minute.

4 A report’s designer can also allow users to link from one report to other related reports, as shown in the image below.
Data exploration helps expand your understanding of the data in your original report, and provides critical insight to make business decisions.

**Running ad hoc reports**

A single MicroStrategy report can be designed so that it serves the needs of many users. To do this, use prompts. Prompts are questions presented to the user when they run a report, asking them to indicate what data they want to see.

By answering prompts, users select filtering criteria and report content dynamically each time the report is run. Prompts are the most commonly used personalization option.

For example, the prompt below is called an object prompt, a feature unique to MicroStrategy. It asks the user to select the types of objects they want to see on the report, such as attributes, metrics, and filters. With an object prompt, users can effectively design the report themselves.
Prompt questions can be displayed in a number of styles, including shopping cart, drop-down, check boxes, radio buttons, text boxes, and calendars.

Users can save their prompt answers so the same responses are used the next time the report is executed. If this same prompt is also used on a different report, the saved prompt answers will be available in the second report.

By using prompts instead of creating an individual report for each user, the total number of reports is far more manageable.

For an introduction to and examples of all the prompts you can create in MicroStrategy, see the Building Query Objects and Queries, for Designers chapter in the Basic Reporting Guide. This chapter includes a table of all prompt types, along with uses for each prompt.

Exploring data on a mobile device with MicroStrategy Mobile

With MicroStrategy Mobile, you and other business users receive the same reports and dashboards on your iPhones, iPads, Android devices, and BlackBerry smartphones as you do in MicroStrategy Web, MicroStrategy Office, or MicroStrategy Desktop. You can analyze and interact with your data by sorting data, repositioning objects, grouping data by page, and more.

For full details, images, and examples on any of the features described below, see the MicroStrategy Mobile Analysis Guide.

Prerequisites

- You must have the MicroStrategy Mobile Server installed and configured, and have the MicroStrategy Mobile client installed on your mobile device. For steps, see Chapter 1, Get Started with the MicroStrategy Suite.

- You must have the Use MicroStrategy Mobile privilege in MicroStrategy for at least one MicroStrategy project. This privilege allows you to access MicroStrategy projects from your mobile device. For information on assigning privileges, see Chapter 5, Additional Security Configurations or contact your administrator.

- You must have the Mobile View Document privilege in MicroStrategy. This privilege allows you to view dashboards (a type of Report Services
document). For information on assigning privileges, see *Chapter 5, Additional Security Configurations* or contact your administrator.

Steps are below for viewing reports and dashboards on the following mobile devices:

- *Analyzing reports and dashboards from an iPhone, page 127*
- *Analyzing reports and dashboards from an iPad, page 140*
- *Analyzing reports and dashboards from a BlackBerry, page 147*

**Analyzing reports and dashboards from an iPhone**

The steps below walk you through some of the common tasks that an analyst can perform on an iPhone using MicroStrategy Mobile. It is intended for analysts who run and analyze MicroStrategy reports and dashboards using the MicroStrategy Mobile client application on an iPhone.

**Starting MicroStrategy Mobile for iPhone**

To run the MicroStrategy Mobile application

1. Tap the **MicroStrategy Mobile** icon.

2. Type your MicroStrategy **User Name** and **Password**, if required.
When the iPhone client application opens, the default Home screen is displayed, shown below:

By default, the Home screen displays buttons that serve as links to:

- **Reports**: Tap this to display all reports and documents that you have mobile subscriptions to. Shaking the device updates the list. Tap a report or document to run it.

- **Shared Library**: Tap this to display the MicroStrategy projects that your iPhone connects to. Tapping a project displays the folders within it. Tapping a report or document runs it.

- **Settings**: Tap this to change login information, server information, and general administrative and display options for the application.

- **Help**: Tap this to open Help topics that explain various features.

The buttons available on your Home screen can vary if an administrator configures the screen to display other options. For example, buttons can open a report, launch a micro application, open a specific folder for browsing, and so on. The Home screen can also be configured to run a single report or document instead of displaying buttons. For details about customizing the Home screen, see the *Administering MicroStrategy Mobile* chapter of the *MicroStrategy Mobile Design and Administration Guide*. 
You can return to the Home screen at any time by tapping the Home icon, as shown below. This icon is displayed at the top of your iPhone screen when you are browsing top-level folders in a project.

Running reports and exploring data

With MicroStrategy Mobile, you can run, view, and navigate through reports and dashboards on your device.

Running reports and dashboards

Grid reports are the most commonly used type of reports. A grid report organizes business data into rows and columns. The images below show different grid reports displayed on an iPhone:
Graph reports display data visually in a style such as a bar, line, or pie graph. The images below show some examples of graph reports displayed on an iPhone:

Dashboards are used to display data from multiple reports in a presentation-quality format. Dashboards can contain a variety of graphics.
and text, depending on their design. Some typical dashboards are shown below:

You can run a report or a dashboard by either navigating to it through the folders in a project, or you can run one from a subscription list using the Reports button on the default Home screen. Both sets of steps are below.

The Reports button displays a list of the reports and dashboards to which you have a Mobile subscription. In addition, MicroStrategy Mobile comes with several mobile reports by default in the Shared Library. MicroStrategy Mobile runs mobile reports and dashboards on a defined schedule and delivers them to your mobile device. For details to create a subscription, see the MicroStrategy Web Help.

To run subscribed-to reports and dashboards

1. From the default Home screen, tap Reports. A list of subscribed-to reports and dashboards is displayed.

2. Tap a report or dashboard on the list to run it. The report or dashboard data is displayed.
Exploring data on a mobile device with MicroStrategy Mobile © 2012 MicroStrategy, Inc.

To run reports and dashboards from a folder within a project

1 From the default Home screen, tap **Shared Library**. From the list of projects that is displayed, select the project that contains the report or dashboard that you want to run.

   • If your device is configured to connect to only one project, the Shared Library button displays a list of the folders contained within the project.

2 Browse to the folder that contains the report or dashboard to run.

3 Tap the report or dashboard to run it. The report or dashboard data is displayed.

**Answering prompts**

Some reports and dashboards request your input to define what data is displayed. A report or dashboard requests this information by displaying one or more questions, called prompts.

Prompts allow the user to display only the data that meets specific requirements. For example, a user may be interested in a report’s data for only the year 2010. Or he may only want to see sales numbers for his geographical region. Prompts let a user select the specific subset of data that he wants to see.
The methods of answering a prompt depend on the type of prompt you are answering. Prompts are divided into the following groups, based on what is required to answer them:

- Prompts that require you to define a date and/or time, using a calendar or a date/time wheel, as shown below.

![Date Calendar](image)

- Prompts that require you to type information into a text box, as shown below.

![Text Box](image)
• Prompts that require you to select a number using a slider, a stepper, or a wheel, as shown below.

• Prompts that require you to specify your location based on information returned by Google Maps, as shown below.

• Prompts that require you to scan (using the iPhone camera) or type a barcode number, as shown below.
• Prompts that require you to swipe to select one or more items from a list, as shown below.

For details on creating prompts for reports and dashboards to be displayed on an iPhone, see the Designing Reports and Documents for Mobile Devices chapter in the MicroStrategy Mobile Design and Administration Guide.

Navigating reports and dashboards

After a report has been displayed, you can perform the following actions to analyze data on most grid reports and graph reports:

• Tap the report to toggle between full screen mode and non-full screen mode. (The designer must enable full screen mode for the report or dashboard.) Full screen mode displays as much data on the screen as possible. Non-full screen mode displays a navigation bar at the top of the report, with a back button and the name of the report.

• Change the orientation between portrait and landscape by rotating the device.

• Scroll across large reports by swiping the middle of the screen horizontally. To scroll up and down, swipe the middle of the screen vertically.

• On some reports, business data is grouped (in a page-by) across the top of a report. To change the group of data that is displayed, tap the currently displayed group of data at the top of the report, and choose another group. You can also swipe horizontally at the edge of the screen to move between groups of data.

• View tooltips to explain parts of a graph, such as a single bar in a bar graph. To do this, tap the bar and hold on the screen.

You can perform the following actions on a dashboard:
• Change the orientation between portrait and landscape by rotating the device.

• Zoom by pinching on the center of the screen, or double-tap the center of the screen to switch between zoomed-in and zoomed-out views.

For more details on navigating the data in an out-of-the-box widget, see Visualizing data in an out-of-the-box widget, page 138.

Accessing application and data links

A link is a connection between the currently displayed MicroStrategy dashboard and another dashboard or report. When tapped, a link executes a target dashboard or report from the currently displayed (source) dashboard.

Links in MicroStrategy dashboards can be displayed to users as either images or text. To follow a link that is displayed in a dashboard, tap the linked image or text.

When a link executes a report or dashboard, the link can change the following properties of the report or dashboard that it executes:

• Define the grouping of data in a target report or dashboard
• Change the layout of a target dashboard
• Determine whether a target report is displayed as a grid, a graph, or a combination of both grid and graph
• Change the prompt answers that are used in a target report or dashboard
In addition, a link in a dashboard can access applications that are stored on your device, such as email, phone, text messages (SMS), and maps, as shown below:

For details to create links in dashboards, see the Designing Reports and Documents for Mobile Devices chapter in the MicroStrategy Mobile Design and Administration Guide.

Analyzing data in reports and dashboards

You can interact easily with a report or dashboard on your iPhone to analyze data and take action. Steps in this section show you how to do the following:

- Visualizing data in an out-of-the-box widget, page 138
- Drilling through the data, page 139
- Viewing a subset of data, page 140

Full descriptions for analyzing data on an iPhone are available in the MicroStrategy Mobile Analysis Guide.
Visualizing data in an out-of-the-box widget

Data can be displayed in an interactive, tabular layout on an iPhone using the Interactive Grid widget, shown below:

With this widget, business attributes and metric values are displayed in the columns and rows, and grouping appears at the top of the screen. The actions that you can perform with an Interactive Grid widget depend on how the widget is designed to provide interactivity. For details on defining a report to display as an Interactive Grid widget, see Displaying a report as an Interactive Grid widget on a mobile device, page 93.

Depending on how the widget that you are analyzing was designed, you can perform any of the following:

- If a column contains more than one metric, tap the metric name at the top of the report to toggle between different metrics.
- Tap the names of groups of data (page-bys) at the top of the report to display different groups of data.
- Tap objects in the report to drill to additional, related data. For details on drilling, see Drilling through the data, page 139.
- Tap objects to follow links. For details on linking, see the Designing Reports and Documents for Mobile Devices chapter in the MicroStrategy Mobile Design and Administration Guide.
• Tap the center of the screen once to toggle between full screen mode and non-full screen mode.

A Time Series widget displays data over a specific period of time. Data is displayed in a line graph. A Time Series widget can contain multiple data series on the same graph. For example, the values for the Deficit Rate of Change metric for the US and the world over a six-month period are displayed in the Time Series widget below:

The actions you can perform with a Time Series widget depend on how the widget is designed to provide various interactivity. For details on defining a report to display as a Time Series widget, see Displaying a report as a Time Series widget on a mobile device, page 95.

Depending on the widget that you are analyzing, you can do any of the following:

• When the widget is viewed in landscape mode, tap the center of the screen to toggle between full screen and non-full screen mode.

• Tap and hold on the graph to display tooltips containing information on the data being reviewed.

• Swipe horizontally to scroll through the time axis.

• Swipe at the edges of the screen to page through data.

• Tap the headings to toggle through different metrics.

**Drilling through the data**

Some MicroStrategy reports and dashboards allow you to view information at multiple levels. For example, a report displays time at the Year level by default, but can also display data grouped by Quarter or Month. If you can drill to other levels of data, the values that you can drill on will be underlined.
To change the level at which you are viewing data, tap an underlined object on the report. The data is displayed on a different level. These levels of drilling are defined by a report’s or dashboard’s drill map.

**Viewing a subset of data**

Some MicroStrategy reports and dashboards display a question, called a prompt, that you must provide an answer for, before the report/dashboard finishes execution. Your answer to the prompt is used to determine what subset of data to display.

Some reports and dashboards allow you to change your prompt answer to display different subsets of data without having to re-execute the report or dashboard. Reports and dashboards that allow you to change your prompt answer show a Filter button at the top of the screen when viewed in non-full screen mode, as displayed below:

To change your prompt answers after the report has run, tap **Filter**. The prompt screen is displayed, and you can change your prompt answers.

For details on answering prompts, see the *Getting Started with MicroStrategy Mobile for iPhone* chapter in the *MicroStrategy Mobile Analysis Guide*.

For a full list of manipulations available in the MicroStrategy Mobile iPhone client application, see the *Analyzing Reports and Documents on an iPhone* chapter in the *MicroStrategy Mobile Analysis Guide*.

**Analyzing reports and dashboards from an iPad**

This section provides an overview of some of the common tasks that an analyst can perform on an iPad using MicroStrategy Mobile for iPad. It is intended for analysts who run and analyze MicroStrategy reports and dashboards using the MicroStrategy Mobile for iPad client application.
Starting MicroStrategy Mobile for iPad

To run the MicroStrategy application on your iPad

1. On your iPad, tap the MicroStrategy Mobile icon, as shown below:

2. Enter your MicroStrategy **User Name** and **Password**, if required.

3. When the application opens, the Home screen is displayed. By default, the Home screen lets you access the MicroStrategy projects that you are connected to, any reports that you have subscribed to, and reports that you recently accessed.

You can tilt your iPad to view the Home screen in landscape mode. In this mode, you can use the left pane to navigate within your projects, and use the right pane to view additional information about a selected object. Tap **Refresh** to refresh the list of projects on the Home screen.

The icons on your Home screen may vary, depending on the configuration set up by your administrator. For example, you may see additional shortcuts to reports and dashboards. The Home screen can also be configured to run a single report or dashboard instead of displaying buttons. For details on customizing the Home screen, see the *MicroStrategy Mobile Design and Administration Guide*.

From the menu, you can select from the following options:

- **Home**: Displays the list of projects.
- **Reports**: Displays the reports and dashboards that the user is subscribed to.

You can tap the Information icon 🔄 to display other options:

- **Settings**: Displays version information and the status of the application. If the **Allow users to access Settings** check box is selected (on the iPad Settings tab of the Mobile Configuration page in MicroStrategy Web), the Settings screen also displays configuration settings such as the memory limit.
• **Help:** Displays the Help for the application.

## Running reports and exploring data

Once you have started MicroStrategy Mobile, you can navigate through your project and run reports and dashboards on the iPad.

### Running reports and dashboards

#### To run reports and dashboards that you have subscribed to

1. On the iPad, from the Home screen, tap **Reports**. In portrait mode, the button is located at the top of the screen. In landscape mode, it is at the bottom left.

   The list of reports and dashboards that you have subscribed to opens. For reports and dashboards that you have run before, a thumbnail preview is displayed. If a report/dashboard has been recently updated with new data, it is displayed with the caption **New**.

2. Tap a report’s thumbnail or icon to run it.

   You can also browse through folders in a project to locate reports/dashboards to run them.

#### To run reports and dashboards by browsing to their location

1. On the iPad, from the Home screen, tap a project’s icon. The folders within the project are displayed.

2. Browse to the folder that contains the report or dashboard to run.

   **To run a report or dashboard in portrait mode**

3. To run a report or dashboard in portrait mode, tap the report’s icon to run it. The report or dashboard is displayed.
To run a report or dashboard in landscape mode

4 To run a report or dashboard in landscape mode, tap the report’s icon. The description, last date accessed, and additional information about the report or dashboard is displayed in the right pane.

5 Tap View to run the report or dashboard.

Answering prompts

When executed, some reports and dashboards request your input to define what data is displayed. A report or dashboard requests this information by displaying one or more questions, called prompts.

The methods of answering a prompt on the iPad are similar to the iPhone. For details, see Answering prompts, page 132.

For more information on creating prompts for the iPad, see the MicroStrategy Mobile Design and Administration Guide.

Navigating reports and dashboards

The following are some common methods that you can use to move around within most grid reports and graph reports:

• You can view reports in portrait or landscape mode by rotating the iPad.

• To scroll across large reports, drag your finger on the screen horizontally. To scroll up and down, drag your finger on the screen vertically.

• To switch between viewing the report as a grid or a graph, tap the Graph icon at the top right of the screen.

• Business data may be grouped into pages, designed by a page-by across the top of the report. Tap the currently displayed group of data at the top of the report and choose another group, or switch to another group using gestures. For details on page-bys, see the MicroStrategy Mobile Analyst Guide.

• To view tooltips to explain parts of a graph, such as a single bar in a bar graph, tap and hold on the screen.
The following are some common methods that you can use to move around in most dashboards:

- To zoom in on a dashboard, pinch the center of the screen or double-tap the center of the screen to switch between a zoomed-in view and a zoomed-out view.

- A dashboard may contain one or more widgets, which are a type of interactive graph. Widgets may be placed on panels that are then stacked on top of each other, allowing you to navigate between the panels like pages. MicroStrategy Mobile for iPad lets you switch panels with a horizontal swipe. You can also tap circles, which appear on a dark gray bar at the bottom of a panel stack, to select individual panels of data. For details on the row of circles (called selectors), see *Providing subsets of data on an iPad dashboard, page 103.*

### Accessing other iPad apps using links

A MicroStrategy dashboard can use links to open other iPad apps, such as Safari, Mail, and Google Maps. For example, a dashboard may report sales per employee. When you view the dashboard, you can tap a link to send an email to an employee using Mail.

In iOS version 3.2, tapping a link to a website or email address closes MicroStrategy Mobile and opens Safari or Mail. To return to the dashboard, exit Safari or Mail, start MicroStrategy Mobile, tap the Recents tab, and tap your dashboard’s icon to run it.

The dashboard designer determines how apps are accessed from the dashboard, and what actions the apps perform. For details about designing dashboards for an iPad, see the *MicroStrategy Design and Administration Guide.*

### Analyzing reports and dashboards on the iPad

You can interact easily with a report or dashboard on your iPad to analyze data and take action. Steps are below to perform the following:

- *Drilling through the data, page 145*
- *Viewing a subset of data by changing prompt answers, page 147*

Full descriptions for analyzing data on an iPad are available in the *MicroStrategy Mobile Analysis Guide.*
Drilling through the data

Drilling lets you view your data at levels other than those displayed in the report. For example, a report displays data at the year level by default. You can drill down to view the same data at the quarter level. Alternatively, you can drill to another dimension, such as Geography, to view data at the city level.

If drilling is enabled, Drill Anywhere appears when you tap and hold an attribute heading or attribute element, as shown below:

Steps are below to drill on a grid report and on a graph report.

To drill on a grid report

1. On the iPad, with a grid report open, tap and hold on an attribute heading or attribute element.
2 Tap **Drill Anywhere**. The drill path selector is displayed, with a list of dimensions to which you can drill, as shown in the example below.

To cancel drilling at any time, tap the **Close** icon in the top right corner of the drill path selector.

3 Scroll through the displayed dimensions until the dimension that you want to drill to is in the center.

4 Tap the dimension’s name. The dimension is added to the drill path on the left, and a list of attributes representing that dimension is displayed.

5 Repeat the procedure to add an attribute to the drill path. The **Update** icon appears, as shown below.

To change your selections, tap the name of the first dimension that you selected, shown in blue at the far left. The drill path is reset.

6 Tap **Update** to refresh the report with data for your chosen attribute.
To drill on a graph report

1. On an iPad, with a graph report open, tap and hold a data point on the graph. A tooltip is displayed showing additional information about the data point.

2. In the tooltip, tap the Information icon.

3. Tap Drill Anywhere. The drill path selector is displayed, with a list of dimensions to which you can drill.

4. Scroll through the displayed dimensions until the dimension to drill to is in the center.

5. Tap the dimension’s name. The dimension is added to the drill path on the left, and a list of attributes representing that dimension is displayed.

6. Repeat the steps to add an attribute to the drill path. The Update icon appears.

7. Tap Update to refresh the report with data for your chosen attribute.

Viewing a subset of data by changing prompt answers

MicroStrategy reports and dashboards that contain prompts use your prompt answers to display a subset of data. Some reports and dashboards may allow you to change your prompt answers to display different subsets of data without having to navigate to the report and re-execute it.

Reports and dashboards that allow you to change your prompt answers display a Filter button at the top of the screen (in non-full screen mode). To change your prompt answers after the report is run, tap Filter. The prompt screen is displayed, and you can change your prompt answers.

Analyzing reports and dashboards from a BlackBerry

This section provides an overview of the main tasks that an analyst can perform with the MicroStrategy Mobile application on a BlackBerry smartphone. This section is intended for analysts who intend to run and analyze the data in MicroStrategy reports and dashboards using MicroStrategy Mobile.
Managing subscriptions for reports and dashboards

To receive reports and dashboards on a BlackBerry smartphone, the user must be subscribed to reports or dashboards.

Each Mobile subscription is associated with a MicroStrategy schedule that controls how often the report or dashboard on the device is delivered. Once a report or dashboard is delivered the first time, subsequent deliveries update the content in the report or dashboard. The schedule that is associated with a subscription determines the frequency of updates to a report or dashboard on a smartphone.

Prerequisites

• When subscribing a user to a report, be sure that the user has the appropriate privileges to view the report or dashboard and the objects it contains:
  □ To view reports on a BlackBerry using MicroStrategy Mobile, users must have the Use MicroStrategy Mobile privilege for all projects containing reports they want to view.
  □ To view dashboards on a BlackBerry using MicroStrategy Mobile, users must have the Mobile View Documents privilege for all projects containing dashboards they want to view.

For a complete list of user privileges in MicroStrategy, see the Privileges and Permissions chapter in the MicroStrategy Supplemental Reference for System Administration. For details about assigning privileges, see the Setting Up User Security chapter in the MicroStrategy System Administration Guide.

• If you are designing a report or a dashboard to be viewed on a BlackBerry, review the best practices for designing reports to be viewed on a BlackBerry, in the Designing Reports and Documents for Mobile Devices chapter in the MicroStrategy Mobile Design and Administration Guide. Reports and dashboards designed according to these best practices load quickly and are easy to read on BlackBerry smartphones.

Subscribing to a single report or dashboard

You can create subscriptions and manage them using the Properties dialog box for each report or dashboard. Steps are provided below.
**Prerequisites**

To manage your Mobile subscriptions in MicroStrategy Desktop, you must have the following privileges:

- Use Desktop privilege
- Use MicroStrategy Mobile privilege
- To subscribe to a dashboard, you must have the Mobile View Document privilege

---

**To subscribe to a single report or dashboard**

1. From your computer’s **Start** menu, select **Programs, MicroStrategy, Desktop**, and then select **Desktop** again. MicroStrategy Desktop opens.

2. Log in to the project that contains the report or dashboard you want to subscribe to.

3. Locate and right-click the report/dashboard and select **Schedule Delivery To**, then select **Mobile**. The Mobile Subscription Editor opens.

4. Type a name for the subscription in the **Name** field. Select the schedule from the **Schedule** drop-down list.

5. Click to select recipients for the subscription.

6. From the **Mobile Device Type** drop-down list, select **BlackBerry**.
   
   For details on all the options in the Mobile Subscription Editor, click **Help**.

7. Click **OK**. The Mobile Subscription Editor closes.

For details to manage subscriptions using MicroStrategy Web, see the *MicroStrategy Mobile Design and Administration Guide*.

For full details on schedules and subscriptions and steps to create them in bulk, see the *Automating Tasks* chapter in the *MicroStrategy System Administration Guide*. 
Running MicroStrategy Mobile for the BlackBerry

To run the MicroStrategy Mobile application

To start MicroStrategy Mobile for BlackBerry

1  On the main menu on your BlackBerry, select the MicroStrategy Mobile icon, shown below:

2  Type your MicroStrategy User Name and Password, if required.

Retrieving Mobile-enabled reports and dashboards

3  When the BlackBerry client application opens, a list of reports and dashboards is displayed. These are the reports and dashboards to which you are subscribed. To ensure that the list is as up to date as possible, click and select Reconcile Now.

Determining whether data is up to date

4  From the list of reports and dashboards, you can quickly determine whether a report/dashboard has been updated with the most recent data:

   • A report/dashboard that needs to be reconciled has a red X through it and its name appears in gray.

   • A report/dashboard that contains data displays its name in black.

You can specify a time window during which new and updated reports and dashboards are sent to your BlackBerry. For details, see the Getting Started with MicroStrategy Mobile for BlackBerry chapter in the MicroStrategy Mobile Analysis Guide.

Running reports and exploring the data

In the list of reports and dashboards that is displayed when you open MicroStrategy Mobile, you can determine whether a report/dashboard has already been run using the following visual cues:

   • A green check mark appears next to reports/dashboards that have already been run.
• Reports/dashboards that have not been run are displayed as follows:
  ▪ A grid or graph icon (with no green check mark) appears if the report/dashboard has been refreshed but has not been run.
  ▪ A red X appears if the report/dashboard needs to be refreshed.

Running a report or dashboard

To run a report or dashboard

1  Select the MicroStrategy Mobile application to open MicroStrategy Mobile.

2  Click and select **Reconcile Now**. All reports and dashboards that you are subscribed to are displayed.

3  Click the report or dashboard to open and select **Open Report**. The report is displayed.

4  When you are finished viewing a report, click **Escape** to return to the list of reports and dashboards.

Answering prompts

Some reports and dashboards require user input to define what data is displayed. When one of these prompted reports/dashboards is run in Desktop or Web, the prompt is displayed when you run the report/dashboard.

However, prompted reports/dashboards on a BlackBerry receive their answers from the subscription information you provide when you set up a subscription. Prompted reports/dashboards on a BlackBerry display results according to the answers specified when the subscription was created.

You can edit a subscription at any time to change the answers that are provided for the prompts in a prompted report/dashboard.

For complete details on editing a subscription and providing prompt answers, see the *Getting Started with MicroStrategy Mobile* chapter in the *MicroStrategy Mobile Analysis Guide*. 
For an introduction to prompts and prompted reports, see the *MicroStrategy Basic Reporting Guide*.

### Viewing data

When you run a report on your BlackBerry, it is displayed in either a grid view or a graph view, depending on how it was saved in MicroStrategy Desktop or Web.

Grid reports are separated into columns and rows of data, as shown in the images below:

#### Grid reports

<table>
<thead>
<tr>
<th>Customer Region</th>
<th>Min Sales per Customer</th>
<th>Avg Sales per C</th>
</tr>
</thead>
<tbody>
<tr>
<td>North-East</td>
<td>9</td>
<td>235</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>120</td>
<td>270</td>
</tr>
<tr>
<td>South-East</td>
<td>9</td>
<td>200</td>
</tr>
<tr>
<td>Central</td>
<td>5</td>
<td>341</td>
</tr>
<tr>
<td>South</td>
<td>4</td>
<td>209</td>
</tr>
<tr>
<td>North-West</td>
<td>6</td>
<td>334</td>
</tr>
<tr>
<td>South-West</td>
<td>7</td>
<td>300</td>
</tr>
<tr>
<td>England</td>
<td>16</td>
<td>617</td>
</tr>
<tr>
<td>France</td>
<td>12</td>
<td>462</td>
</tr>
</tbody>
</table>

#### Region Performance (Thresholds)

<table>
<thead>
<tr>
<th>Region</th>
<th>Sales</th>
<th>LY $</th>
<th>YoY %</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>North-East</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>South-East</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Central</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>South</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>North-West</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>South-West</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>England</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>France</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Germany</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>1/10</th>
</tr>
</thead>
<tbody>
<tr>
<td>North-East</td>
<td></td>
</tr>
</tbody>
</table>
Graph reports present data visually in a style such as a bar, line, or pie graph style. The images below show examples of graph reports displayed on a BlackBerry:

![Top 5 Suppliers by Revenue](image1)

![Inventory Turns vs Profit Trend](image2)

When you run a dashboard, it is displayed as a collection of separate reports. Each grid or graph report in the dashboard is displayed on its own tab, with the tabs arrayed above the data. The image below shows a dashboard on a BlackBerry; the reports that are contained within the dashboard - Region, Category, and Time - appear as separate tabs across the top.

<table>
<thead>
<tr>
<th>Region</th>
<th>Category</th>
<th>Time</th>
<th>Dollar Sales</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>North-East</td>
<td>$39,546</td>
<td>$3,758</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$41,014</td>
<td>$7,536</td>
<td></td>
<td></td>
</tr>
<tr>
<td>South-East</td>
<td>$28,766</td>
<td>$5,361</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Central</td>
<td>$15,495</td>
<td>$3,065</td>
<td></td>
<td></td>
</tr>
<tr>
<td>South</td>
<td>$15,388</td>
<td>$2,858</td>
<td></td>
<td></td>
</tr>
<tr>
<td>North-West</td>
<td>$14,392</td>
<td>$2,365</td>
<td></td>
<td></td>
</tr>
<tr>
<td>South-West</td>
<td>$25,537</td>
<td>$4,657</td>
<td></td>
<td></td>
</tr>
<tr>
<td>England</td>
<td>$12,498</td>
<td>$2,241</td>
<td></td>
<td></td>
</tr>
<tr>
<td>France</td>
<td>$9,724</td>
<td>$1,779</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Central</td>
<td>4/10</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Scrolling through data

After you have run a report or dashboard, there are several ways to navigate through it and view the data.

You can scroll through the data to get a sense of its purpose and to determine whether it will suit your business requirements.

The bar at the bottom of a report/dashboard displays information contained in the cell that you currently have highlighted. As you scroll through values in a report, the name of that each value you scroll through is displayed in the bottom bar, along with the total number of values contained within the selected column. For example, in the report below, there are a total of 11 countries, and France is the ninth country listed:

To navigate the data in a report or dashboard

2. Click and select Reconcile Now.
3. Click the report that you want to open and select Open Report.
4. Scroll down the data in the columns and rows of the report:
   - To scroll vertically, roll the trackball/trackwheel.
   - To scroll horizontally, hold ALT and roll the trackball/trackwheel.
   - To view an independent report within a dashboard, scroll to the tab(s) at the top of the report and select a tab.
   - To view the data in all the columns of a given row, click the row and select Row Details. The columns and values for the selected row are displayed.
Fitting the data into the screen

You can customize how the data is displayed, locate specific values, group and sort data to narrow your analysis, and more.

Results may not be fully displayed on a report or dashboard for a number of reasons:

- The font size of the report results may be too large
- The column heading names or some of the data values are not displayed or are not fully displayed because they do not fit
- Not all the data columns can be seen because they do not fit

When data must be cut short to fit the screen, ellipses are displayed, as shown in the image below:

![Example of ellipses in a report](image)

To fix these issues, you can adjust the display of an individual report/dashboard, or for all reports/dashboards.

To adjust the font size in an individual report/dashboard

1. Click the report or dashboard to open and select Open Report.
2. Click and select any of the following to adjust the display:
   - Select Font Size and then select the current font size. From the drop-down list, select a new font size for the report. As you change the font size, the report is updated to provide a preview of the new font size.
   - Select Fit to Screen. The report is adjusted so that the maximum amount of data is displayed at one time.
Exploring Data with MicroStrategy Suite

- Select **Fit to Content**. The report is adjusted so that the column headings and values are fully visible.

  ! The Fit to Screen and Fit to Content options may not be available if the report is already using these modes. However, if you manually resized one of the columns in the report, both these options will be available.

  3 Select **OK** to apply the changes to the report/dashboard.

**Sorting the data**

To display data in the most efficient way for analysis, you can sort the data and reorganize how the data is displayed in a report/dashboard.

You cannot sort data on some reports/dashboards. For example, you cannot sort data of those reports/dashboards that are designed in Original Layout Data view. For details, see the *Designing Reports and Documents for Mobile Devices* chapter in the *MicroStrategy Mobile Design and Administration Guide*.

You can sort on any column that is on a report. (If the report/dashboard contains a custom group or consolidation, you cannot sort on either of these types of data.) When you sort, you determine the sorting order, either ascending or descending.

---

**To sort the data on a report or dashboard**

1 Click the report or dashboard and select **Open Report**.

2 Select the heading of the column you want to sort. To move horizontally across the columns of a report, hold ALT and scroll.

3 From the menu, select either **Sort Ascending** or **Sort Descending**.

4 To save the report with the current sort order, click and select **Save**.

**Grouping data by page**

A large set of data on a report is generally easier to analyze and understand if you can look at only certain subsets of data at one time. To group data into subsets, use the Page-by feature while viewing a report, as described in the steps below.
For example, if you move the Category column to a page-by field, the elements of the Category attribute are displayed in the page-by, allowing you to toggle between pages of data, one page for each element.

Some reports already have objects in their page-by field because they were designed that way in MicroStrategy Desktop or Web. When you view one of these reports in MicroStrategy Mobile, the page-by field is displayed at the top of the report and can be selected to change the view of data on the report.

**To group data into subsets (pages)**

1. Click the report or dashboard and select **Open Report**.
2. Select the column heading which contains the data that you want to group into a page-by. You can place attributes or metrics in a page-by. To move across columns horizontally, hold ALT and scroll.
3. Click and select **Page By Selection**. The attribute or metric is placed in the page-by field above the report.

**To view a page of results**

a. Select the page-by field above the report. The Select an Element of (Attribute Name) page opens.

b. Select an element to view from the list of elements. The report displays the subset of data you selected, which is now shown in the current page-by field at the top of the report.

c. Change the subset of data displayed by clicking the page-by field and selecting another element.

4. To save the report with the current page-by selections, click and select **Save**.

**Moving objects on reports and dashboards**

You can rearrange the columns in a report so that you can view data from different perspectives.
To move objects on a report or dashboard

1. Click the report or dashboard to open and select **Open Report**.

2. Select the heading of the column that you want to move. To scan across a report horizontally, hold ALT and scroll.

3. From the menu, select **Move Left** or **Move Right**. The column of data is shifted to the left or right.

4. To save the report with these changes, click and select **Save**.

For a complete list of manipulations that you can perform on a report or dashboard on a BlackBerry, as well as more details to run and view report and dashboard data, see the *Analyzing Reports and Documents on a BlackBerry* chapter in the *MicroStrategy Mobile Analysis Guide*. 
Introduction

This chapter covers optional configurations for your MicroStrategy Suite. The configurations described below can help to expand your MicroStrategy Suite applications to support a more diverse user base.

Configuring security

MicroStrategy administration is centralized in a single metadata repository, which can store information about all the different reports and objects necessary for many different business departments. Access to the reporting objects in your MicroStrategy metadata repository is restricted based on the permissions and privileges held by each individual MicroStrategy user.

Every Suite user who logs into the MicroStrategy system should have a unique MicroStrategy login. This enables system administrators to grant those users access to the appropriate data, and to track all changes made in your MicroStrategy project.
You can control access to your MicroStrategy project in three ways:

- **Privileges** control what functionality in the MicroStrategy system the user has access to. For example, a user who does not have the Use Metric Editor privilege cannot create or edit metrics. Privileges are assigned to the user’s account by right-clicking the user and selecting **Edit**.

- **Security filters** control what data the user has access to. For example, a user who has a security filter that restricts him to only the California Central Region element of the Region attribute cannot view any data for any other state or region. Security filters are assigned to the user’s account by right-clicking the user and selecting **Edit**.

- **Permissions** control what objects in the MicroStrategy system the user has access to. For example, a user who has the Write permission for a metric can make changes to the metric’s definition, while a user who only has the Execute permission can run reports containing the metric but cannot change that metric.

Each MicroStrategy object has an access control list (ACL), which specifies the permissions that each MicroStrategy user has for that object. Permissions are assigned to the objects in MicroStrategy by right-clicking the object, selecting **Properties**, then selecting **Security**.

User groups can be granted privileges, security filters, and permissions in the same way as individual users. A user can be a member of multiple groups, and inherit the security settings from each group.

Steps are below to create a user, create and apply a security filter to a user, and set permissions for a user to access (or restrict access to) an object. For complete details related to user and object security, see the **Setting Up User Security** chapter in the *MicroStrategy System Administration Guide*.

---

**To create a user and configure its security profile**

1. In MicroStrategy Desktop, log in to the project source you create. For information on connecting to a data source, see *To establish an Intelligence Server connection to the metadata repository, page 24.*
2 In Desktop, on the left side, expand **Administration** and then expand **User Manager**.

![Image of MicroStrategy Desktop](image.png)

**To create a user**

3 Right-click **Everyone**, point to **New**, and select **User**. The User Editor opens, as shown below.

![Image of User Editor](image.png)

4 Type the basic user information, such as login name, full name, and password, in the fields. For detailed information about each field, click **Help**.
To assign privileges to the user

5 On the left side of the User Editor, under **User Definition** select **Project Access**.

6 Select the check boxes for the privileges or privilege groups you want the user to have. For a detailed description of every privilege in MicroStrategy, see the *Permissions and Privileges* chapter in the *Supplemental References for System Administration Guide*. 
To assign a security filter to the user

7 On the left side of the User Editor, under **User Definition**, select **Security Filter**.

8 Select your project from the **Projects that have been granted access** drop-down list and click **View**. The Security Filter Manager opens.

9 Since you are just starting out with MicroStrategy, you can create a new security filter and then assign it to the user. You can apply your new security filter to any other user you add. To create a new security filter, click **New**.
10 Define the conditions for the security filter by creating qualifications or adding qualifications to the new security filter. These qualifications define the data the user is allowed to view on a report. To do this, double-click in the Filter Definition pane on the right. The Filtering Options pane opens.

11 Select Add an Attribute Qualification and click OK.

12 Select an attribute depending on what type of data you want the security filter to apply to:

- To filter data related to an attribute’s form:
  a Select the attribute whose form you want to qualify data on.
  b In the Attribute Qualification pane, from the Qualify On drop-down list, click the attribute form on which you want to qualify the report.
  c Click an operator in the Operator list.
  d In the Value field, type the value to use to qualify on the attribute form; this is the value that will be compared against the data in your data source.

- To filter data based on elements of an attribute:
  a Select the attribute that has the elements on which you want to qualify.
  b In the Attribute Qualification pane, from the Qualify On drop-down list, select Elements.
  c From the Operator drop-down list, select either In List (to define what attribute elements the filter should include data for) or Not In List (to define what attribute elements the filter should exclude data for).
  d Click Add.
  e In the Available Objects list, select attribute elements and then click the right arrow > to add them to the Selected Objects list. Then click OK to close the Selected Objects dialog box.

For details on each option to create a security filter, click Help.

13 Click OK to close the Attribute Qualification pane.

14 When you are finished defining the security filter, click Save and Close.
15 To assign a security filter to the user you created above, select the security filter and click the right arrow >. The selected security filter is moved to the Security Filters area.

16 Click OK. The Security Filter Manager closes and the selected security filters are assigned to this user for your MicroStrategy reporting project and any other projects you later create within this project source.

17 Click OK. The User Editor closes and the user is created.

---

**To set permissions for a user on a specific object**

1 Browse to the object (usually an attribute or metric) that you want to set permissions for.

2 Right-click the object and select Properties. The Object Properties dialog box opens. On the left, select Security.
3 Click **Add**. The Select Desktop Users and Groups dialog box opens, as shown below.

![Select Desktop Users and Groups dialog box](image)

4 **Select the Show Users check box.**

5 **In the list of users, select the user you want to change permissions for.**

6 **Click OK.** The Select Desktop Users and Groups dialog box closes, and the user is listed in the **Permissions** area of the Object Properties dialog box, as shown below.

![Object Properties dialog box](image)
7 Locate the user name in the **User** column and click the **Object** column next to the user name. Select the desired permission from the drop-down list.

8 Click **OK**. The Object Properties dialog box closes, and the user’s permissions for the object are saved.
Introduction

This appendix provides answers and solutions for common questions and issues you may encounter when installing, configuring, or using the MicroStrategy Suite software.

Requesting or retrieving a license key

You must request a license key for the MicroStrategy Suite to install and use the software. After you request the license key, you must retrieve the license key that is sent to you.

The following steps show you how to request a license key and how to retrieve a license key after you have requested it.

Prerequisite

- You must be a registered user of the MicroStrategy website. Create a user account by providing your email address, password, and other details. To create an account, in your web browser, go to https://
resource.microstrategy.com/login/, type your details in the boxes provided, and then click **Create Account**.

After your account is created, you can log in to the MicroStrategy site and retrieve a license key.

---

**To request or retrieve a license key**

1. In your web browser, go to [www.microstrategy.com/freeereportingsoftware](http://www.microstrategy.com/freeereportingsoftware).
2. At the top right, click **Download Your Free Software**.
3. Log into the site with your user name (your email address) and password.
4. Fill in the appropriate information and click **Submit**. The license key is sent to your email address.

---

**Returning to the Suite download page**

You can return to the Suite download page to retrieve your license key, download the Suite installation files, and review additional resources for installing and configuring your Suite software.

**Prerequisites**

- You have previously accessed the Suite download page and requested a Suite license (see *Requesting or retrieving a license key, page 169*).

---

**To return to the Suite download page**

1. Open the email that you received in your inbox with the subject line "Thank you for your interest in MicroStrategy Suite!"
2. Click the **Download** link provided in the email. The Download Software page opens.
Locating the downloaded zip file

Installing the MicroStrategy Suite requires you to download a zip file to your computer. If you forget where you downloaded the zip file to, you can locate it by searching in your computer for the appropriate file name. The names of the downloaded files are listed in *To install the MicroStrategy Suite, page 11*.

Installing on a certified operating system

Your MicroStrategy Suite software must be installed on an operating system that is certified or supported by MicroStrategy. The list of certified and supported operating systems on which you can install the Suite software can be found in the *MicroStrategy Readme*. For information on accessing the Readme, see *Documentation, page 178*.

Common installation mistakes related to operating systems include:

- Installing on versions of Microsoft Vista that are not currently certified or supported by MicroStrategy.
- Installing on older versions of Microsoft Windows that are no longer supported by MicroStrategy.

Be sure to check the list of certified and supported operating systems that MicroStrategy provides, to ensure that your computer’s operating system is listed as either certified or supported.

Installing MicroStrategy on Windows XP

If you are installing MicroStrategy Web and MicroStrategy Mobile Server on a Windows XP computer, be aware that you cannot deploy both of these products using the IIS on that computer, due to a limitation of IIS. If you are deploying MicroStrategy on a Windows XP computer, you must do one of the following:

- Use a web server product other than IIS to deploy at least one of these two MicroStrategy products. For steps to install and configure Tomcat, see *Installing Tomcat if IIS is earlier than 6.0, page 31*. 
Installing Microsoft IIS

If you plan to use IIS (Internet Information Services) to deploy MicroStrategy Web and MicroStrategy Mobile Server, Microsoft IIS must be installed on the same computer where you install the MicroStrategy Suite software. You must also install the .ASP and .NET frameworks, if they are not already installed on the computer. These frameworks are installed by default along with IIS, in all versions of IIS except IIS version 7.

IIS is installed by default on Windows server operating systems, and is an optional component on other Windows operating systems. For information on installing IIS on your Windows operating system, refer to the third-party Microsoft documentation provided at http://www.iis.net/.

If you install IIS 7, be aware that you must also install the .ASP and .NET frameworks, if they are not already installed on the computer. To be sure these additional components are installed and enabled when you install IIS, see the steps in Supporting MicroStrategy with IIS 7, page 172.

If you install IIS 6 and your computer is running a 64-bit Windows operating system, you must configure some MicroStrategy products as 64-bit applications. To perform these steps, see Supporting MicroStrategy with IIS 6 on 64-bit Windows operating systems, page 173.

Supporting MicroStrategy with IIS 7

To enable all necessary products related to IIS 7

The steps below may differ slightly depending on your version of Windows. The third-party products discussed below are manufactured by vendors independent of MicroStrategy, and the steps to configure these products is subject to change. Refer to the appropriate Microsoft documentation for steps to configure IIS 7.

1. On a Windows computer, from the Start menu, select Control Panel.
2. Double-click Programs and Features.
3. Click the Turn Windows features on or off task. The Windows Features dialog box opens.
4 Expand **Internet Information Services**, and select the following options:

a. Expand **Web Management Tools** and select:
   - IIS Management Console
   - IIS Management Scripts and Tools
   - IIS Management Service

b. Expand **World Wide Web Services**, then expand **Application Development Features**, and select:
   - .NET Extensibility
   - ASP.NET
   - ISAPI Extensions
   - ISAPI Filters

c. Within **World Wide Web Services**, expand **Common Http Features**, and select:
   - Default Document
   - Static Content

d. Expand **Security**, and select:
   - Request Filtering
   - Windows Authentication

5 Click **OK** to save your changes.

**Supporting MicroStrategy with IIS 6 on 64-bit Windows operating systems**

If you plan to use IIS 6 on 64-bit Windows operating systems, some MicroStrategy products must be configured as 64-bit applications. These requirements are described below:

- For MicroStrategy products that must be configured as 64-bit applications on 64-bit Windows operating systems, you must define the IIS parameter `Enable32BitAppOnWin64` as False (0). These MicroStrategy products include:
  - MicroStrategy Intelligence Server
Resolving an installation issue during the WSE 3.0 phase

Your MicroStrategy Suite installation may not progress beyond the Installing MicroSoft Web Services Enhancements (WSE) 3.0 phase. If your installation does not continue beyond this phase, use either or both of the following options to fix the issue:

- If you are installing the files from a network location, you may encounter this issue. Make sure that you are using installation files that are stored on a local drive.


Resolving a JVM memory-related error

You may see an error which states that you do not have enough memory to create the JVM. This error message occurs when other processes on the computer are using or reserving memory, causing insufficient system resources.

To resolve this problem, close or otherwise disable software and processes that are using or reserving memory. You can find suggestions for this issue in the MicroStrategy User Forum at:

https://resource.microstrategy.com/forum/replylistpage.aspx?id=1231

For additional assistance with your system memory and how to disable processes, contact your system administrator.
Resolving error code 0x80070005

This error code typically means that the user account on the computer where you are trying to install the MicroStrategy Suite does not have the proper privileges to install this software.

Contact your organization’s administrator for permission or privilege issues related to your computer.

Addressing issues with number of CPUs

CPU message with activation email

You may notice that when you activate your Suite software, the activation message you receive displays a list of various statistics about the computer on which you are installing the software. An example of this list is shown below:

```
The following activation information has been recorded with this activation to assist with identifying this Server Installation.

Server Installation ID: 38204
Installation Date: 7/7/2009
Installation Name: TEST-CPU
Location: John Doe's office
Usage: Development
Activation Method: Automatic
Activation ID: 5
Activation Date: 7/7/2009 1:10:21 PM
Contract ID: 10000
Operating System: Windows XP

Number of CPUs: 2

```

The number of CPUs listed in the activation message is a count of the physical CPUs that the activation process finds on your computer. It does not reflect the number of CPUs that the MicroStrategy software will use.

The Suite software licensing is limited to one CPU for MicroStrategy Intelligence Server. It is also limited to one CPU for MicroStrategy Mobile Server. These two products may both use the same CPU, or they may use different CPUs. However, MicroStrategy CPU usage is unrelated to the information displayed in the activation message you receive via email. You
can install on a server with multiple processors and multiple cores, but the software has an affinity to a single core unless you upgrade by purchasing standard Technical Support.

Logging in to the Suite software

MicroStrategy comes with a default login. The default login includes the following user name and does not have a password:

- **User Name:** administrator
- **Password:** Leave this blank

It is possible to change the default login name and password, so if the default credentials above do not work, the person who installed and configured the Suite software may have changed them.

Addressing issues with number of users

If you have chosen to install MicroStrategy’s sample Tutorial project, this project and its related project source come with a number of sample users. These sample users are included in the system’s user count for licensing purposes.

If you want to remove these sample users from the user license count, you can select all the sample users (except Administrator), right-click, and select **Disable**.
Additional Resources

Online support, training, and videos

The MicroStrategy Suite site provides the following online resources:

- **Online support** features a full, easily searchable technical knowledge repository, aimed to ensure your success with MicroStrategy. Visit the support site at:

  https://resource.microstrategy.com/support

- **Online training** allows users to extend their BI knowledge via self-paced, expert instruction and product simulations on a user-friendly interface. Visit the training site at:

  https://resource.microstrategy.com/education/CourseCatalog.aspx

- **Online video guides** help answer immediate questions and get you jump-started in your development. See the video guides at:

  http://www.microstrategy.com/frereportingsoftware/demovideos#getstarted
Documentation

MicroStrategy provides both manuals and online help; these two information sources provide different types of information, as described below:

- **Manuels**: In general, MicroStrategy manuals provide:
  - Introductory information and concepts
  - Examples and images
  - Checklists and high-level procedures to get started

  The steps to access the manuals are described in *Accessing manuals and other documentation sources, page 184*.

  Most of these manuals are also available printed in a bound, soft cover format. To purchase printed manuals, contact your MicroStrategy Account Executive with a purchase order number.

- **Help**: In general, MicroStrategy help provides:
  - Detailed steps to perform procedures
  - Descriptions of each option on every software screen

  For the most up-to-date translations of MicroStrategy documentation, refer to the MicroStrategy Knowledge Base. Due to translation time, manuals in languages other than English may contain information that is one or more releases behind. You can see the version number on the title page of each manual.

MicroStrategy overview and evaluation

- **Introduction to MicroStrategy: Evaluation Guide**

  Instructions for installing, configuring, and using the MicroStrategy Evaluation Edition of the software. This guide also includes a detailed, step-by-step evaluation process of MicroStrategy features, where you perform reporting with the MicroStrategy Tutorial project and its sample business data.


  Overview of the installation and evaluation process, and additional resources.
• *Evaluate MicroStrategy for Linux Guide: In a Windows or Linux Environment with the MicroStrategy Evaluation Edition Virtual Appliance*

Evaluate MicroStrategy for Linux, in a Microsoft Windows or Linux environment, with the MicroStrategy Evaluation Edition Virtual Appliance. This guide provides all details to download, activate, and evaluate MicroStrategy software running in a Linux environment.

• *MicroStrategy Suite: Quick Start Guide*

Evaluate MicroStrategy as a departmental solution. Provides detailed information to download, install, configure, and use the MicroStrategy Suite.

**Resources for MicroStrategy Social Intelligence**

• Alert Commerce Management System (CMS) Guide and Alert API Reference

Content resources designed to provide instructions for delivering and managing marketing and commerce content through the Alert for Facebook web and mobile applications.

• Usher Pro Administration Guide

Instructions for performing mobile identity validation using the Usher Pro mobile identity network to issue electronic badges for identifying users.

• Wisdom Professional User Guide

Instructions for performing market research and consumer analytics.

**Manuals for query, reporting, and analysis**

• *MicroStrategy Installation and Configuration Guide*

Information to install and configure MicroStrategy products on Windows, UNIX, Linux, and HP platforms, as well as basic maintenance guidelines.

• *MicroStrategy Upgrade Guide*

Instructions to upgrade existing MicroStrategy products.
• **MicroStrategy Project Design Guide**

Information to create and modify MicroStrategy projects, and understand facts, attributes, hierarchies, transformations, advanced schemas, and project optimization.

• **MicroStrategy Basic Reporting Guide**

Instructions to get started with MicroStrategy Desktop and MicroStrategy Web, and how to analyze data in a report. Includes the basics for creating reports, metrics, filters, and prompts.

• **MicroStrategy Advanced Reporting Guide: Enhancing Your Business Intelligence Application**

Instructions for advanced topics in the MicroStrategy system, building on information in the Basic Reporting Guide. Topics include reports, Freeform SQL reports, Query Builder reports, filters, metrics, Data Mining Services, custom groups, consolidations, and prompts.


Instructions for a business analyst to execute and analyze a document in MicroStrategy Desktop and MicroStrategy Web, building on basic concepts about projects and reports presented in the *MicroStrategy Basic Reporting Guide*.

• **MicroStrategy Report Services Document Creation Guide: Creating Boardroom Quality Documents**

Instructions to design and create Report Services documents, building on information in the *MicroStrategy Report Services Document Analysis Guide*. It is organized to help guide you through creating a new document, from creating the document itself, to adding objects to the new document, and formatting the document and its objects.

• **MicroStrategy Dashboards and Widgets Creation Guide: Creating Interactive Dashboards for your Data**

Instructions for designing and creating MicroStrategy Report Services dashboards, a type of document that is optimized for viewing online and for user interactivity. It builds on the basic concepts about documents presented in the *MicroStrategy Report Services Document Creation Guide*.

• **MicroStrategy OLAP Services Guide**

Information on MicroStrategy OLAP Services, which is an extension of MicroStrategy Intelligence Server. OLAP Services features include
Intelligent Cubes, derived metrics, derived elements, dynamic aggregation, view filters, and dynamic sourcing.

- **MicroStrategy Office User Guide**

  Instructions for using MicroStrategy Office to work with MicroStrategy reports and documents in Microsoft® Excel, PowerPoint, Word, and Outlook, to analyze, format, and distribute business data.

- **MicroStrategy Mobile Analysis Guide: Analyzing Data with MicroStrategy Mobile**

  Information and instructions for using MicroStrategy Mobile to view and analyze data, and perform other business tasks with MicroStrategy reports and documents on a mobile device.

- **MicroStrategy Mobile Design and Administration Guide: A Platform for Mobile Intelligence**

  Information and instructions to install and configure MicroStrategy Mobile, as well as instructions for a designer working in MicroStrategy Desktop or MicroStrategy Web to create effective reports and documents for use with MicroStrategy Mobile.

- **MicroStrategy System Administration Guide: Tuning, Monitoring, and Troubleshooting your MicroStrategy Business Intelligence System**

  Concepts and high-level steps to implement, deploy, maintain, tune, and troubleshoot a MicroStrategy business intelligence system.

- **MicroStrategy Supplemental Reference for System Administration: VLDB Properties, Internationalization, User Privileges, and other Supplemental Information for Administrators**

  Information and instructions for MicroStrategy administrative tasks such as configuring VLDB properties and defining data and metadata internationalization, and reference material for other administrative tasks.

- **MicroStrategy Functions Reference**

  Function syntax and formula components; instructions to use functions in metrics, filters, attribute forms; examples of functions in business scenarios.

- **MicroStrategy MDX Cube Reporting Guide**

  Information to integrate MicroStrategy with MDX cube sources. You can integrate data from MDX cube sources into your MicroStrategy projects and applications.
Manuals for Analytics Modules

- Analytics Modules Installation and Porting Guide
- Customer Analysis Module Reference
- Sales Force Analysis Module Reference
- Financial Reporting Analysis Module Reference
- Sales and Distribution Analysis Module Reference
- Human Resources Analysis Module Reference

Manuals for Narrowcast Services products

- MicroStrategy Narrowcast Server Getting Started Guide
  Instructions to work with the tutorial to learn Narrowcast Server interfaces and features.

- MicroStrategy Narrowcast Server Installation and Configuration Guide
  Information to install and configure Narrowcast Server.

- MicroStrategy Narrowcast Server Application Designer Guide
  Fundamentals of designing Narrowcast Server applications.

- MicroStrategy Narrowcast Server System Administrator Guide
  Concepts and high-level steps to implement, maintain, tune, and troubleshoot Narrowcast Server.

- MicroStrategy Narrowcast Server Upgrade Guide
  Instructions to upgrade an existing Narrowcast Server.

Software Development Kits

- MicroStrategy Developer Library (MSDL)
  Information to understand the MicroStrategy SDK, including details about architecture, object models, customization scenarios, code samples, and so on.
• **MicroStrategy Web SDK**
  
  The Web SDK is available in the MicroStrategy Developer Library, which is sold as part of the MicroStrategy SDK.

• **Narrowcast Server SDK Guide**
  
  Instructions to customize Narrowcast Server functionality, integrate Narrowcast Server with other systems, and embed Narrowcast Server functionality within other applications. Documents the Narrowcast Server Delivery Engine and Subscription Portal APIs, and the Narrowcast Server SPI.

**Documentation for MicroStrategy Portlets**

• **Enterprise Portal Integration Help**
  
  Information to help you implement and deploy MicroStrategy BI within your enterprise portal, including instructions for installing and configuring out-of-the-box MicroStrategy Portlets for several major enterprise portal servers.

  This resource can be accessed using the MicroStrategy Product Manuals page, as described in *Accessing manuals and other documentation sources, page 184*.

**Documentation for MicroStrategy GIS Connectors**

• **GIS Integration Help**
  
  Information to help you integrate MicroStrategy with Geospatial Information Systems (GIS), including specific examples for integrating with various third-party mapping services.

  This resource can be accessed using the MicroStrategy Product Manuals page, as described in *Accessing manuals and other documentation sources, page 184*. 
Help

Each MicroStrategy product includes an integrated help system to complement the various interfaces of the product as well as the tasks that can be accomplished using the product.

Some of the MicroStrategy help systems require a web browser to be viewed. For supported web browsers, see the MicroStrategy Readme.

MicroStrategy provides several ways to access help:

- **Help button:** Use the Help button or ? (question mark) icon on most software windows to see help for that window.

- **Help menu:** From the Help menu or link at the top of any screen, select MicroStrategy Help to see the table of contents, the Search field, and the index for the help system.

- **F1 key:** Press F1 to see context-sensitive help that describes each option in the software window you are currently viewing.

  For MicroStrategy Web, MicroStrategy Web Administrator, and MicroStrategy Mobile Server, pressing the F1 key opens the context-sensitive help for the web browser you are using to access these MicroStrategy interfaces. Use the Help menu or ? (question mark) icon to access help for these MicroStrategy interfaces.

Accessing manuals and other documentation sources

The manuals are available from [http://www.microstrategy.com/producthelp](http://www.microstrategy.com/producthelp), as well as from your MicroStrategy disk or the machine where MicroStrategy was installed.

Adobe Acrobat Reader is required to view these manuals. If you do not have Acrobat Reader installed on your computer, you can download it from [http://get.adobe.com/reader/](http://get.adobe.com/reader/).

The best place for all users to begin is with the *MicroStrategy Basic Reporting Guide*.

To access the installed manuals and other documentation sources, see the following procedures:

- *To access documentation resources from any location, page 185*
To access installed manuals and other documentation sources on Windows, page 185

To access installed manuals and other documentation sources on UNIX and Linux, page 185

To access documentation resources from any location

1 Visit http://www.microstrategy.com/producthelp.

To access installed manuals and other documentation sources on Windows

1 From the Windows Start menu, choose Programs (or All Programs), MicroStrategy, then Product Manuals. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

2 Click the link for the desired manual or other documentation source.

3 If you click the link for the Narrowcast Services SDK Guide, a File Download dialog box opens. This documentation resource must be downloaded. Select Open this file from its current location, and click OK.

If bookmarks are not visible on the left side of an Acrobat (PDF) manual, from the View menu click Bookmarks and Page. This step varies slightly depending on your version of Adobe Acrobat Reader.

To access installed manuals and other documentation sources on UNIX and Linux

1 Within your UNIX or Linux machine, navigate to the directory where you installed MicroStrategy. The default location is /opt/MicroStrategy, or $HOME/MicroStrategy/install if you do not have write access to /opt/MicroStrategy.

2 From the MicroStrategy installation directory, open the Documentation folder.
Accessing additional documentation resources prior to installation

Once you have extracted the installation files, you can review additional documentation resources prior to installing MicroStrategy. The steps below show you how to access these additional documentation resources.

Prerequisites

• You have downloaded and extracted the installation files.

To access additional documentation resources

1 Navigate to the folder in which you extracted the installation files.

2 Open the Help folder.

3 Open the **Product_Manuals.htm** file in a web browser. A page opens in your web browser showing a list of available manuals in PDF format and other documentation sources.

4 Click the link for the desired manual or other documentation source. The following documentation sources provide important information to support the installation of MicroStrategy:

   • **MicroStrategy Readme**: The MicroStrategy Readme provides requirements to support the installation of MicroStrategy products.
• **Installation and Configuration Guide**: The *Installation and Configuration Guide* provides additional information to help support the installation and initial configuration of MicroStrategy products. Refer to this guide if you encounter any installation issues related to your specific environment.

## Documentation standards

MicroStrategy online help and PDF manuals (available both online and in printed format) use standards to help you identify certain types of content. The following table lists these standards.

These standards may differ depending on the language of this manual; some languages have rules that supersede the table below.

<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
</table>
| **bold**      | • Button names, check boxes, options, lists, and menus that are the focus of actions or part of a list of such GUI elements and their definitions  
Example: Click **Select Warehouse**. |
| **italic**    | • Names of other product manuals and documentation resources  
• When part of a command syntax, indicates variable information to be replaced by the user  
Example: The *aggregation level* is the level of calculation for the metric.  
Example: Type *copy c:\filename d:\foldername\filename* |
| **Courier font** | • Calculations  
• Code samples  
• Registry keys  
• Path and file names  
• URLs  
• Messages displayed in the screen  
• Text to be entered by the user  
Example: Sum(revenue)/number of months.  
Example: Type *cmdmgr -f scriptfile.scp* and press **Enter**. |
| **+**         | A keyboard command that calls for the use of more than one key (for example, SHIFT+F1) |
| ![]           | A note icon indicates helpful information for specific situations. |
| []            | A warning icon alerts you to important information such as potential security risks; these should be read before continuing. |
**Additional formats**

This book is also available as an electronic publication in the Apple iBookstore, and can be read on an iPhone or iPad with the iBooks app installed. To download this book, search for the book’s title in the iBookstore search bar, or scan the QR code below using your device’s camera.